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1. Introduction
Ce guide de l’utilisateur explique les capacités, l’utilisation et l’entretien des enregistreurs de niveau d’eau  
LevelVent 5, AquaVent 5 et des modèles d’enregistreurs de données de niveau et de température d’eau  
précédents LevelVent et AquaVent. Ce manuel se concentre sur le logiciel Solinst Levelogger (utilisant le  
protocole Solinst), les protocoles SDI-12 et MODBUS étant présentés dans des manuels d’utilisation AquaVent  
séparés. 

Pour commencer à utiliser votre enregistreur de données, installez le logiciel Levelogger version 4.6.3 (ou 
supérieure).  Veuillez visiter : https://downloads.solinst.com/ pour télécharger la version actuelle ou vérifier 
les mises à jour. 

1.1 Enregistreurs de données de niveau d’eau ventilés

Les enregistreurs LevelVent et AquaVent sont des enregistreurs de données précis de température et de  
niveau d’eau. Ils utilisent un transducteur de pression (ventilé) étalonné. Le capteur de pression est ouvert à  
l’air libre via un câble ventilé jusqu’à la surface. Ainsi, les mesures du niveau de l’eau et de la température sont  
automatiquement compensées pour les effets barométriques.

Les enregistreurs de données contiennent un produit desséchant et un filtre hydrophobe là se raccorde où le  
câble ventilé. Le produit desséchant et le filtre hydrophobe n’ont pas besoin d’être remplacés et ils sont conçus  
pour fournir une protection contre l’humidité pendant toute l’autonomie de l’instrument, tout en permettant  
à l’air de s’évacuer vers le transducteur. 

Avec un revêtement cuit au four utilisant la technologie de polymérisation, les enregistreurs LevelVent 5  et 
AquaVent 5 offrent une résistance élevée à la corrosion dans les environnements difficiles. Ils utilisent  les 
mêmes têtes de puits Wellhead, câbles de communication et câbles ventilés que les anciens modèles de  
Levelvent et Aquavent.
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Modèles 
LevelVent 5 Pleine échelle Précision Résolution
M5 5 m (16.4 ft.) ± 0,3 cm (0,010 pi) 0,001 % de la pleine échelle

M10 10 m (32.8 ft.) ± 0,5 cm (0,016 pi) 0,0006% de la pleine échelle

M20 20 m (65.6 ft.) ± 1 cm (0,032 pi) 0,0006% de la pleine échelle

Tableau 1-1 : Spécifications techniques de l’enregistreur LevelVent 5
Capteur de niveau : Silicium piézorésistif avec capteur en Hastelloy

Gammes : 5, 10, 20 m

Précision ±0,05 % de la pleine échelle

Normalisation : Compensation automatique de la température 

Temp. Comp. Range : 0 à 50 °C

Capteur de température : Thermomètre à résistance de platine (RTD)

Précision du capteur de temp. : ± 0,05 ºC

Résolution du capteur de temp : 0,003 °C

Caractéristiques générales :

Estimation de l’autonomie des 
piles :

10 ans en se basant sur 1 relevé par minute (dans l’enregistreur ;  
pas remplaçables par l’utilisateur)

Précision de l'horloge (typique) : ±1 minute/an (à des températures comprises entre -20 et 80 °C) 

Température de 
fonctionnement :

-20ºC à 80ºC

Nombre maximal de relevés : 150 000 ensembles de données.

Mémoire : En mode d’enregistrement continu ou sans recouvrement

Débit de transmission : 9600 bps USB Solinst

Dimensions : 22 x 173 mm (7/8 x 6,8 po)

Poids : 190 grammes (6,7 onces)

Matériaux mouillés :
Delrin®, Viton®, Polyuréthane (botte TPU), Acier inoxydable 316L, 
Hastelloy, PTFE sans PFAS 

Résistance à la corrosion : 
Revêtement cuit au four utilisant la technologie de  
polymérisation (à l’intérieur et à l’extérieur) et un capteur de  
pression Hastelloy

Modes d’échantillonnage  (à 
l’aide du logiciel Levelogger) :

Linear (Linéaire), Event Based & User-Selectable Schedule with  
Repeat Mode (Basé sur des événements et programmé par  
l’utilisateur avec mode répétition), Future Start (Démarrage  
programmé), Future Stop (Arrêt programmé), Real Time View  
(Visualisation en temps réel)

Taux de mesure : De 0,125 seconde à 99 heures

Compensation barométrique : Automatique

Figure 1-1 : Enregistreur de données  
LevelVent 5

1.1.1 LevelVent 5

Remarque : Pour utiliser le LevelVent 5 avec la version 4.6.3 du logiciel Levelogger, l’enregistreur LevelVent 5 doit utiliser la version 
1.006 du firmware ou une version plus récente. 

Remarque : Le numéro de modèle se réfère à la profondeur d’immersion en dessous du niveau de l’eau que le capteur de  
pression peut supporter, c.-à-d. : l’enregistreur LevelVent 5 qui est disponible en plusieurs modèles : M5, M10 et M20, avec des  
plages de niveau d’eau réel respectives de 5 m (16,40 pieds), 10 m (32,80 pieds). 
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Tableau 1–2 : Spécifications techniques de l’enregistreur AquaVent 5
Capteur de niveau : Silicium piézorésistif avec capteur en Hastelloy

Gammes : 5, 10, 20 m 

Précision ±0,05 % de la pleine échelle

Normalisation : Compensation automatique de la température 

Temp. Comp. Range : 0ºC à 50ºC

Capteur de température : Thermomètre à résistance de platine (RTD)

Précision du capteur de temp. : ± 0,05 ºC

Résolution du capteur de temp : 0,003 °C

Caractéristiques générales :

Estimation de la durée de vie de 
la batterie :

8 ans en se basant sur 1 relevé par minute (remplaçables par  
l’utilisateur dans la tête de puits Wellhead)

Précision de l'horloge (typique) : ±1 minute/an (à des températures comprises entre -20 et 80 °C) 

Température de fonctionnement : -20ºC à 80ºC

Nbre maximal de relevés : 150 000 séries de relevés

Mémoire : En mode d’enregistrement continu ou sans recouvrement

Débit de transmission : Solinst USB 57600 bit/s, SDI-12 1200 bauds, MODBUS RS-232/
RS-  485 (débits divers)

Dimensions : 22 x 173 mm (7/8 x 6,8 po)

Poids: 190 grammes (6,7 onces)

Matériaux mouillés :
Delrin®, Viton®, Polyuréthane (botte TPU), Acier inoxydable 316L, 
Hastelloy, PTFE sans PFAS 

Résistance à la corrosion: 
Revêtement cuit au four utilisant la technologie de  
polymérisation (à l’intérieur et à l’extérieur) et un capteur de  
pression Hastelloy

Modes d’échantillonnage  (à 
l’aide du logiciel Levelogger) :

Linear (Linéaire), Event Based & User-Selectable Schedule with  
Repeat Mode (Basé sur des événements et programmé par  
l’utilisateur avec mode répétition), Future Start (Démarrage  
programmé), Future Stop (Arrêt programmé), Real Time View  
(Visualisation en temps réel)

Taux de mesure : De 0,125 seconde à 99 heures

Compensation barométrique : Automatique

1.1.2 Aquavent 5

Note : Pour utiliser l’AquaVent 5 avec la Version 4.6.3 du logiciel Levelogger, l’enregistreur AquaVent 5 doit utiliser la Version 1.006 
ou supérieure du Firmware. La Wellhead doit utiliser le Firmware Version 1.000 ou supérieure.

Modèles 
AquaVent 5 Pleine échelle Précision Résolution
M5 5 m (16.4 ft.) ± 0,3 cm (0,010 pi) 0,001 % de la pleine échelle

M10 10 m (32.8 ft.) ± 0,5 cm (0,016 pi) 0,0006% de la pleine échelle

M20 20 m (65.6 ft.) ± 1 cm (0,032 pi) 0,0006% de la pleine échelle

Figure 1-2 : Enregistreur  
AquaVent 5
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Tableau 1-3 : Spécifications techniques de l’enregistreur LevelVent
Capteur de niveau : Silicium piézorésistif avec capteur en Hastelloy

Gammes : 5, 10, 20 m (15, 30, 65 ft.)

Précision ±0,05 % de la pleine échelle

Normalisation: Compensation automatique de la température 

Temp. Comp. Range : 0ºC à 50ºC

Capteur de température : Thermomètre à résistance de platine (RTD)

Précision du capteur de température : ± 0,05 ºC

Résolution du capteur de température : 0,003 °C

Caractéristiques générales :

Estimation de l’autonomie des piles :
10 ans en se basant sur 1 relevé par minute (dans 
l’enregistreur ;  pas remplaçables par l’utilisateur)

Précision de l'horloge (typique) :
±1 minute/an (à des températures comprises entre -20 
et 80 °C) 

Température de fonctionnement : -20ºC à 80ºC

Nbre maximal de relevés 40,000

Mémoire :
En mode d’enregistrement continu ou sans 
recouvrement

Débit de transmission : 9600 bps USB Solinst

Dimensions : 22 x 178 mm (7/8 x 7 po) 

Poids: 129 grammes (4,5 oz)

Matériaux mouillés : Delrin, Viton, Acier inoxydable 316L, Hastelloy

Modes d’échantillonnage  (à l’aide du 
logiciel Levelogger) :

Linear (Linéaire), Event Based & User-Selectable 
Schedule with  Repeat Mode (Basé sur des événements 
et programmé par  l’utilisateur avec mode répétition), 
Future Start (Démarrage  programmé), Future Stop (Arrêt 
programmé), Real Time View  (Visualisation en temps 
réel)

Taux de mesure : De 0,125 seconde à 99 heures

Compensation barométrique : Automatique

1.1.3 LevelVent

Remarque : Pour utiliser l’appareil LevelVent avec la version 4.6.3 du logiciel Levelogger, l’enregistreur LevelVent doit utiliser la 
version 1.000 ou supérieure du micrologiciel. 

Figure 1-3 : Enregistreur LevelVent

Modèles 
LevelVent Pleine échelle Précision Résolution

M5 5 m (16.4 ft.) ± 0,3 cm (0,010 pi) 0,001 % de la pleine échelle

M10 10 m (32.8 ft.) ± 0,5 cm (0,016 pi) 0,0006% de la pleine échelle

M20 20 m (65.6 ft.) ± 1 cm (0,032 pi) 0,0006% de la pleine échelle
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Tableau 1–4 : Spécifications techniques de l’enregistreur AquaVent
Capteur de niveau : Silicium piézorésistif avec capteur en Hastelloy

Gammes : 5, 10, 20 m (15, 30, 65 ft.)

Précision ±0,05 % de la pleine échelle

Normalisation: Compensation automatique de la température 

Temp. Comp. Range : 0ºC à 50ºC

Capteur de température : Thermomètre à résistance de platine (RTD)

Précision du capteur de température : ± 0,05 ºC

Résolution du capteur de température : 0,003 °C

Caractéristiques générales :

Estimation de l’autonomie des piles :
8 ans en se basant sur 1 relevé par minute (remplaçables 
par  l’utilisateur dans la tête de puits Wellhead)

Précision de l'horloge (typique) : ± 1 minute/an (-20ºC à 80ºC) 

Température de fonctionnement : -20ºC à 80ºC

Nombre maximal de relevés : 40,000 

Mémoire : En mode d’enregistrement continu ou sans recouvrement

Vitesse de communication :
Solinst USB 9600 bit/s, SDI-12 1200 bauds, MODBUS RS-
232/  RS-485 (débits divers), débit de téléchargement de 
données :  57 600 bit/s

Dimensions : 22 x 178 mm (7/8 x 7 po) 

Poids: 129 grammes (4,5 oz)

Matériaux mouillés : Delrin, Viton, acier inoxydable 316L

Modes d’échantillonnage  (à l’aide du 
logiciel Levelogger) :

Linear (Linéaire), Event Based & User-Selectable 
Schedule with  Repeat Mode (Basé sur des événements 
et programmé par  l’utilisateur avec mode répétition), 
Future Start (Démarrage  programmé), Future Stop (Arrêt 
programmé), Real Time View  (Visualisation en temps réel)

Taux de mesure : 0,125 seconde à 99 heures

Compensation barométrique : Automatique

1.1.4 AquaVent

Remarque : Pour utiliser l’AquaVent avec la Version 4.6.2 du logiciel Levelogger, l’enregistreur AquaVent doit utiliser la Version 
1.000 ou supérieure du Firmware. La Wellhead doit utiliser le Firmware Version 1.000 ou supérieure.

Modèles 
d’AquaVent Pleine échelle Précision Résolution

M5 5 m (16.4 ft.) ± 0,3 cm (0,010 pi) 0,001% FS

M10 10 m (32.8 ft.) ± 0,5 cm (0,016 pi) 0,0006 % FS

M20 20 m (65.6 ft.) ± 1 cm (0,032 pi) 0,0006 % FS

Figure 1-4 : Enregistreur AquaVent
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1.2 Paramètres de mesure

1.2.1 Niveau

Les transducteurs LevelVent et AquaVent détectent à la fois la pression de  l’eau 
(W) et la pression atmosphérique (+B). Toutefois, un tube de ventilation  à la 
surface permet d’éliminer les effets barométriques sur le capteur de  pression 
(-B). Ainsi, un LevelVent et AquaVent fournissent des relevés de la  pression 
réelle de l’eau juste au-dessus du point zéro du capteur de pression  (A). 
L’équation montre la manière dont les capteurs de pression fonctionnent : 

Figure 1-5 :  Références fondamentales 
pour les mesures  avec un enregistreur de 

données ventilé

1.2.1.1 Étalonnage de la pression

Les enregistreurs LevelVent et AquaVent sont des enregistreurs étalonnés par  
rapport à un large éventail de points de référence pour obtenir une précision à  
3 chiffres après la virgule. Au cours de la procédure d’étalonnage, l’enregistreur  
est entièrement immergé dans un bain d’eau dont le niveau est connu avec une  
très grande précision jusqu’à ce que les conditions soient stables. La pression  
est alors étalonnée pour six points de pression distincts couvrant la gamme  
complète des pressions pour l’enregistreur spécifique, afin de détecter toute  
non-linéarité. Le processus est répété à deux températures différentes pour  
vérifier les effets de la température. Cela accompli, l’enregistreur est approuvé  
après que toutes les spécifications d’exactitude, de précision, de stabilité et  
d’hystérésis ont été vérifiées. L’étalonnage de l’enregistreur devrait durer toute  
la durée de vie de l’instrument, du moment qu’il est utilisé conformément aux  
spécifications techniques, dans des environnements de surveillance compatibles  
avec des inspections de routine et qu’il n’est pas physiquement, chimiquement  
ou thermiquement endommagé.

1.2.2 Température

Les enregistreurs LevelVent et AquaVent enregistrent les niveaux d’eau  
compensés en température. Les relevés de température des eaux souterraines  
et des eaux de surface sont particulièrement importants dans les situations où  
la température peut fluctuer considérablement, et sa précision est importante  
pour déterminer le niveau de liquide, la viscosité et la conductivité hydraulique.  
La surveillance de la température est essentielle dans le calcul de certaines  
vitesses de réaction de contaminants dépendantes de la température. Un  
détecteur de température à résistance de platine est utilisé pour compenser  
avec précision les variations de température dans la plage de 0 à +50 °C.  
Les enregistreurs LevelVent et AquaVent enregistrent les températures dans sa  
plage de température de -20 à +80 °C, mais en dehors de la plage étalonnée  
de 0 à +50 °C, la compensation est moins précise.

A = (W + +B) + (-B)   
Par conséquent, A=W (voir Figure 1-5).

A	  	 = relevés d’enregistreur LevelVent/AquaVent  
W 	 = hauteur de la colonne d’eau  
+B 	 = pression atmosphérique détectée par le capteur de pression 
-B 	 = pression atmosphérique appliquée par le câble ventilé

A 		 = D (profondeur du point zéro de l’AquaVent) - d (mesure de la 
profondeur jusqu’au niveau de l’eau)

Point de la  
mesure zéro
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1.3 Composants du système LevelVent

L’enregistreur LevelVent 5 nécessite les composants suivants pour réaliser un système de surveillance :

•	 Enregistreur LevelVent 5
•	 Têtes de puits de communication LevelVent 
•	 Câble d’interface PC
•	 Câble ventilé
•	 Logiciel Solinst Levellogger 
 	 (téléchargement gratuit sur solinst.com)

Figure 1-6 : Système LevelVent 5 complet Enregistreur 
LevelVent 5

Câble 
ventilé

Tête de puits Wellhead  
LevelVent 5

Câble d’interface PC (USB) 

Remarque : Le câble d’interface de PC a 2,3 m (7,5 pieds) de longueur. 

1.3.1 Tête de puits de communication LevelVent 

La tête de puits LevelVent 5 est extrêmement compacte et s’insère parfaitement dans l’ouverture d’un  
ensemble de couvercle de puits Solinst de 5 cm (2 pouces) (un adaptateur de 10 cm (4 pouces) est disponible). 

La tête de puits LevelVent 5 a une connexion à lecture directe qui permet de raccorder un câble d’interface  
PC, utilisé pour les communications, avec le logiciel Solinst Levelogger pour PC. La tête de puits Wellhead  
permet également une connexion directe à un DataGrabber 5 ou une application Levelogger 5 App Interface  
(voir les manuels d’utilisation et les instructions séparés).

Remarque : La tête de puits LevelVent Wellhead ne contient pas de pile. La pile se trouve dans l’enregistreur LevelVent 5 et n’est  
pas remplaçable par l’utilisateur.
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La tête de puits Wellhead contient un filtre hydrophobe là où le câble ventilé se termine au niveau de la surface.  
Le filtre hydrophobe n’a pas besoin d’être remplacé ; il est conçu pour fournir une protection contre l’humidité  
pendant toute la durée de vie opérationnelle de l’instrument. Le filtre protège le câble contre l’humidité,  
tout en laissant l’air circuler dans le tuyau d’aération, ce qui se traduit par l’effet d’annulation de la pression  
barométrique sur le LevelVent 5.   

Chaque Wellhead est fournie avec un ensemble de couvercle de puits de 5 cm (2 pouces), ainsi qu’un support  
de suspension pour soutenir le câble ventilé. Voir la section 8.1.1 pour les instructions d’installation. 

Figure 1-7 : Tête de puits LevelVent

Vue de dessus Vue de dessous
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1.4 Composants du système AquaVent

L’enregistreur AquaVent 5 nécessite les composants suivants pour réaliser un système de surveillance :

•	 Enregistreur AquaVent 5
•	 Tête de puits de communication et câble(s) de connexion AquaVent
•	 Câble ventilé
•	 Logiciel Solinst Levelogger 

Figure 1-8 : Système AquaVent 5 complet

1.4.1 Tête de puits Wellhead et câbles de connexion

La tête de puits AquaVent 5 s'adapte facilement sur un tubage de puits de 2" (50 mm) à l'aide de la base du 
capuchon de puits (un adaptateur de 4" est également disponible). La tête de puits SPX possède une connexion 
à 10 broches (protocole Solinst) pour les câbles communiquant avec le logiciel et les accessoires Solinst, et une 
deuxième connexion à 12 broches pour les câbles communiquant avec des enregistreurs de données tiers ou 
des systèmes de télémétrie utilisant les protocoles MODBUS ou SDI-12 (voir guides). 

Remarque Les câbles de connexion pour tête de puits ont une longueur de 4,5 m (15 ft). Les câbles de connexion de la tête 
de puits à utiliser avec le logiciel et les accessoires Solinst sont identifiés par une bande orange au niveau de la connexion à 10 
broches. La connexion à 10 broches (protocole Solinst) de la tête de puits est également identifiée par une bande orange.

Il existe deux options de câble pour la connexion à 10 broches (protocole Solinst) :

•	 Le câble de connexion USB se connecte à un PC pour la communication avec le logiciel Levellogger.
•	 Connecteur App/DataGrabber Câble de connexion à l'interface App du Levelogger 5, à la SRU ou à 
l'unité de traitement des données DataGrabber 5. Voir le guide de l'utilisateur/les instructions séparés.

Remarque : Il est également possible d’utiliser un câble d’interface USB de PC pour raccorder un câble de connexion App/  
DataGrabber au port USB d’un PC. 

Câble de connexion App/  
DataGrabber

Câble de connexion USB

Câble de connexion  MODBUS 
RS232

Câble de connexion  SDI-12

Câble de  connexion  
MODBUS RS485

Câble 
ventilé

Enregistreur 
AquaVent 5

AquaVent 5 Tête de puits SPX

connexions à 12 
broches

connexions à 10 
broches
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Chaque tête de puits Wellhead est fournie avec 4 piles AA de 1,5 V au lithium remplaçables par l’utilisateur  
qui alimentent l’AquaVent (reportez-vous à la section 8.2.1 pour les instructions d’installation des piles et des  
estimations de l’autonomie des piles). Elles ont une durée de vie utile de 8 ans en se basant sur 1 lecture par  
minute. 

Remarque : Solinst recommande d’utiliser des piles AA de 1,5 V au lithium dans la tête de puits Wellhead. 

Remarque : La petite pile à l’intérieur de l’enregistreur AquaVent 5 sert uniquement à alimenter l’horloge interne de l’enregistreur  
AquaVent 5 lorsqu’il n’est pas raccordé à la tête de puits Wellhead, et pendant les mises à jour du microprogramme. 

Les têtes de puits Wellhead renferment des produits desséchants et un filtre hydrophobe là où le câble ventilé  
se termine au niveau de la surface. Les produits desséchants et les filtres hydrophobes n’ont pas besoin d’être  
remplacés et ils sont conçus pour fournir une protection contre l’humidité pendant toute l’autonomie de  
l’instrument. Le filtre protège le câble contre l’humidité, tout en laissant l’air circuler dans le tuyau d’aération,  
ce qui se traduit par l’effet d’annulation de la pression barométrique sur l’enregistreur AquaVent 5. 

Chaque Wellhead est fournie avec un ensemble de couvercle de puits de 5 cm (2 pouces), ainsi qu’un support  
de suspension pour soutenir le câble ventilé. Voir la section 8.2.2 pour les instructions d’installation. 

Figure 1-9 Options de câbles de tête de puits et de connecteurs SPX  

1.4.1.1 État des LED de la tête de puits de SPX

Les têtes de puits AquaVent Wellhead possèdent un témoin lumineux multichrome qui indique l’état et le  
fonctionnement de l’AquaVent :

3 cycles de clignotement rapides alternant les trois couleurs : la tête de puits Wellhead se met en  
marche
10 cycles de clignotement rapides alternant le bleu et le vert : la tête de puits Wellhead s’est  
connectée correctement à l’ordinateur en utilisant le câble de connexion USB
10 cycles de clignotement rapides alternant le bleu et le rouge : la connexion USB a été interrompue
Jaune clignotant : la tête de puits Wellhead communique avec le logiciel du PC via USB

Remarque : des définitions  supplémentaires des DEL pour la tête de puits SPX sont disponibles dans les guides de l'utilisateur 
séparés pour SDI-12 et MODBUS. 

Câble de connexion USB

Câble de connexion  App/
DataGrabber

Tête de puits SPX
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1.5 Câble ventilé

Les câbles ventilés contiennent des fils d'alimentation et de communication, ainsi qu'un tube de ventilation 
sur toute la longueur du câble. Les câbles ventilés fournissent une communication de lecture directe entre 
l'enregistreur LevelVent 5 ou AquaVent 5 et la tête de puits. Le tube de ventilation et les fils sont gainés 
de polyuréthane, offrant durabilité et protection. Le câble a un diamètre de 8 mm (0,320"), tandis que les 
connecteurs ont un diamètre de 20 mm (0,790"). 

Remarque : Avant l’expédition des câbles ventilés, les tubes de ventilation sont séchés avec de l’azote, puis bouchés  
hermétiquement, afin de garantir l’absence d’humidité pendant le transport. 

Les câbles ventilés sont de longueur sur mesure. Des longueurs jusqu’à 150 m (500 pieds) sont disponibles. 

Remarque : les anciens câbles ventilés (vendus avant le 16/04/21 avec des numéros de série inférieurs à 506326) 
ne sont pas compatibles avec les têtes de puits LevelVent 5 de style plus récent (vendus après le 14/4/21 avec les 
numéros de série 495959 et plus), les enregistreurs LevelVent 5 ( vendues après le 5/5/21), têtes de puits AquaVent 
5 (vendues après le 5/7/21) et enregistreurs AquaVent 5 (vendues après le 5/5/21  sans une petite modification de 
l'utilisateur - contactez Solinst pour obtenir des instructions. 

Les câbles ventilés de style plus récent sont compatibles avec toutes les versions des têtes de puits et des 
enregistreurs – une fois que le nouveau connecteur du câble ventilé est complètement serré, le joint torique externe 
d'un ancien enregistreur ou tête de puits est visible et il est normal de ne pas s'asseoir contre le connecteur.  

1.5.1 Connexions du câble ventilé

Les extrémités du câble ventilé sont munies de raccords femelles tournants compatibles avec les enregistreurs  
LevelVent 5 ou AquaVent 5 et les têtes de puits Wellhead. Ainsi, les câbles ventilés sont interchangeables 
(c’està-  dire que n’importe laquelle de ses extrémités peut être raccordée à une tête de puits ou un enregistreur).  

Remarque : À des fins de diagnostic, vous pouvez installer l’extrémité du câble ventilé portant le numéro de série au connecteur  
de surface de la Wellhead. 

1.5.1.1 Connexion à la tête de puits LevelVent

Enlevez les bouchons d’entreposage des connecteurs de la tête de puits Wellhead et du câble ventilé. 

Figure 1-10 : Câble ventilé

Remarque : Veillez à conserver tous les bouchons d’entreposage pour pouvoir les réutiliser ultérieurement. 
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Alignez la goupille et la cavité d’alignement.

Poussez doucement la tête de puits Wellhead et le câble ventilé ensemble et tournez-les  légèrement jusqu’à ce que 
vous perceviez un petit déclic lorsque le raccordement correct se fait. 

Serrez le raccord en acier inoxydable jusqu’à ce qu’il soit bien en place tout en maintenant  le câble ventilé 
et la tête de puits immobiles. Serrez le raccord jusqu’à ce qu’il soit bien en place.  Veillez à ne pas tordre le câble 

ventilé ou la Wellhead. 

Figure 1-11 : Branchement d’un câble ventilé à la tête de puits LevelVent

Remarque : Lorsque vous raccordez une tête de puits Wellhead ou un enregistreur LevelVent, veillez à ne pas tordre le câble  
ventilé. Faites uniquement tourner le raccord. 

Cavité de positionnement  du 
câble ventilé

Goupille d’alignement  de 
tête de puits

Ailette alignée  
avec la goupille

Ailette alignée  avec la 
cavité  d’alignement

Maintenez la  
tête de puits  

immobile

Maintenez le  câble 
ventilé  immobile

Faites uniquement  
tourner le  raccord
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Alignez la goupille et la cavité d’alignement.

1.5.1.2 Connexion à la tête de puits AquaVent

Remarque : Reportez-vous à la section 8.2.2 pour l’installation de la base du couvercle du puits et du support de fixation du câble  
lorsqu’il est déployé. 

Enlevez les bouchons d’entreposage des connecteurs de la tête de puits Wellhead et du câble ventilé. 

Remarque : Veillez à conserver tous les bouchons d’entreposage pour pouvoir les réutiliser ultérieurement. 

Remarque : À des fins de diagnostic, vous pouvez installer l’extrémité du câble ventilé portant le numéro de série au connecteur  
de surface de la Wellhead. 

Cavité de positionnement  du 
câble ventilé

Goupille d’alignement  de 
tête de puits

Ailette alignée  avec la goupille

Ailette alignée avec la  cavité 
d’alignement
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Poussez doucement la tête de puits Wellhead et le câble ventilé ensemble. Tournez le connecteur  du câble 
légèrement jusqu’à ce que vous perceviez un petit déclic lorsque le raccordement  correct se fait. 

Serrez le raccord en acier inoxydable jusqu’à ce qu’il soit bien en place tout en maintenant  le câble ventilé 
et la tête de puits immobiles. Serrez le raccord en acier inoxydable jusqu’à ce qu’il  soit bien en place. Veillez à ne 

pas tordre le câble ventilé ou la tête de puits Wellhead. 

Figure 1-12 : Branchement d’un câble ventilé à la tête de puits AquaVent

Remarque : Lorsque vous raccordez une tête de puits Wellhead ou un enregistreur AquaVent, veillez à ne pas tordre le câble  
ventilé. Faites uniquement tourner le raccord. 

Maintenez la 
tête  de puits 

Wellhead  
immobile

Maintenez le  
câble ventilé  

immobile

Faites uniquement  
tourner le raccord
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Serrez le raccord en acier inoxydable jusqu’à ce qu’il soit bien en place tout en maintenant le  câble ventilé et 
l’enregistreur immobiles.  Serrez le raccord en acier inoxydable jusqu’à ce qu’il soit bien en place.  Veillez à ne pas 

tordre le câble ventilé ou l’enregistreur. 

Figure 1-13 : Branchement d’un câble ventilé à l’enregistreur

Enlevez les bouchons d’entreposage des connecteurs de l’ AquaVent et du câble ventilé. 

Alignez l’ergot de positionnement de l’enregistreur avec la cavité de positionnement du connecteur du câble 
ventilé.  Poussez doucement la tête de puits Wellhead et le câble ventilé ensemble et tournez-les légèrement 

jusqu’à ce que  vous perceviez un petit déclic lorsque le raccordement correct se fait. 

1.5.1.3 Connexion à l’enregistreur

1.5.2 Précautions concernant le câble ventilé

Si le câble doit être plié au cours de l’installation, assurez-vous que le tube de ventilation n’est pas tordu  
à l’intérieur du câble. Ne laissez pas l’évent devenir comprimé ou aplati à l’intérieur du câble. Un évent  
comprimé ou aplati à l’intérieur du câble peut entraîner une compensation barométrique incorrecte. Afin  
d’éviter un serrage excessif du tube de ventilation, ne pliez pas et n’enroulez pas le câble en boucles  de rayon 
inférieur à 25 mm (1 pouce). 

Un support de suspension spécialement conçu est fourni avec chaque tête de puits Wellhead, afin de soutenir  
le câble ventilé lorsqu’il est déployé. Reportez-vous à la section 8 pour les instructions pour installer le support. 

Au cours de l’installation, faites très attention à ne pas entailler le câble sur un bord tranchant. Une coupure  
de la gaine de protection du câble pourrait laisser l’humidité entrer à l’intérieur du câblage, ce qui pourrait  
entraîner des problèmes de communication ou permettre à l’humidité de descendre le long du câble.

Remarque : Veillez à conserver tous les bouchons d’entreposage pour pouvoir les réutiliser ultérieurement.  

Remarque : Lorsque vous raccordez une tête de puits Wellhead ou un enregistreur, veillez à ne pas tordre le câble ventilé. Faites  
uniquement tourner le raccord. 

Maintenez l’enregistreur  
immobile

Maintenez le  
câble ventilé  

immobile

Faites uniquement  
tourner le raccord
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2 Logiciel Solinst Levelogger

Ce logiciel basé sur Windows® offre de nombreuses fonctions pratiques. Il vous permet d’afficher et de  
programmer les paramètres des enregistreurs de données, démarrer des sessions d’enregistrement, surveiller  
les relevés en temps réel, télécharger des données, gérer des fichiers de données, effectuer des ajustements  
des données, sauvegarder et exporter des fichiers de données. 

Remarque :  Il est toujours recommandé d’utiliser la version la plus récente du logiciel et du micrologiciel. Laissez 
Solinst vous tenir au courant de chaque nouvelle version du logiciel et du micrologiciel. Enregistrez votre logiciel sur 
https://downloads.solinst.com pour recevoir ces mises à jour automatiquement.

Le logiciel Levelogger sert à programmer tous les enregistreurs Solinst. Le logiciel détecte automatiquement  
le type d’enregistreur connecté et affiche uniquement les options de configuration spécifiques à ce type  
d’enregistreur. 

2.1 Spécifications du système

Les spécifications matérielles et logicielles minimales requises pour l’installation et l’exploitation du logiciel 
sont :

Matériel Logiciel
Processeur : 1 GHz ou processeur plus rapide 
ou SoC

Système d’exploitation : Windows 10 et 11

RAM : 1 Go pour 32 bits ou 2 Go pour 64 bits

Espace disque dur : 128 Mo

Affichage : 800 x 600

Ports : USB ou RS-232

Configuration du port de communication pour les communications de l’enregistreur de données :

Bits par seconde 9600

Bits de données 8

Bits d’arrêt 1

Contrôle de débit Aucune
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2.2 Installation du logiciel

Téléchargement depuis le Web

1.	 Téléchargez la dernière version du logiciel Levelogger en vous rendant sur le site : 
https://downloads.solinst.com 

2.	 Si le programme d’installation ne démarre pas automatiquement, cliquez sur le fichier « setup.exe » pour activer  
l’installation du logiciel.

3.	 L’assistant d’installation du logiciel vous guidera à travers le reste du processus d’installation. La Figure 2-1  
montre l’assistant d’installation du logiciel.  	l'assistant d'installation du logiciel.

4.	 Redémarrez l'ordinateur une fois l'installation terminée. Le répertoire par défaut est :  
	 C:\Program Files\Solinst\Levelogger4_6

Figure 2-1 : Assistant nouveau matériel détecté
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2.3 Communication avec le logiciel

Le logiciel Levelogger est basé sur Windows ; il est donc utilisable sur un ordinateur de bureau ou un portable. 

Le LevelVent communique avec un ordinateur de bureau ou un portable en utilisant un câble USB d’interface  
PC raccordé à la tête de puits LevelVent Wellhead. 

Figure 2-2 : Levelogger 5 communiquant avec le logiciel Levelogger

Figure 2-3 : AquaVent 5 communiquant avec le logiciel Levelogger

L'AquaVent communique avec un ordinateur portable ou de bureau à l'aide d'un câble de connexion USB 
connecté à la tête de puits AquaVent. Le câble de connexion USB se connecte à la connexion à 10 broches 
(protocole Solinst).



Guide de l'utilisateur des enregistreurs 
de données ventilés

Page 23

3 Lancement, configuration et paramètres du logiciel

3.1 Démarrage

Branchez le câble USB avant de lancer le logiciel Levelogger.

Pour lancer le logiciel, cliquez sur ou cliquez sur le bouton Démarrer de votre ordinateur et sélectionnez :

Programmes > Solinst > Levelogger 4 > Levelogger 4.6.3

Une fois le programme lancé, vous pouvez configurer les paramètres pour le logiciel. 

3.1.1 Vérifier si des mises à jour du logiciel ou du microprogramme sont disponibles

Chaque fois que le logiciel est ouvert, il vérifie automatiquement si des mises à jour du logiciel sont disponibles  
en ligne. Si une mise à jour est disponible, « Software Update Available » (Nouvelle version du logiciel disponible)  
apparaît en haut à droite de la fenêtre. Lorsque vous cliquez sur le message, une page Web s’ouvre pour vous  
permettre de télécharger la mise à jour du logiciel.

Remarque : Votre PC doit disposer d’une connexion Internet pour vérifier si des mises à jour du logiciel ou du microprogramme 
sont  disponibles.

Après que vous avez extrait les paramètres à partir d’un enregistreur de données connecté, le logiciel vérifie  
également si des mises à jour de la version du capteur (microprogramme) sont disponibles (voir section 4).  « 
Firmware Update Available » (Nouvelle version du microprogramme disponible) apparaît en haut à droite de 
la  fenêtre. Lorsque vous cliquez sur le message, une page Web s’ouvre pour vous permettre de télécharger 
la mise à  jour du microprogramme. Reportez-vous à la section 11 pour les instructions de mise à jour du 
microprogramme.

Remarque : Vous pouvez également vérifier si des mises à jour sont disponibles en utilisant le menu Help (Aide).

3.2 Configuration et paramètres

3.2.1 Répertoire des données

Le programme enregistre les données téléchargées dans le répertoire par défaut suivant : < C:\Program 
Files\Solinst\Levelogger4_6\Data> sauf indication contraire dans le champ Répertoire par défaut de la 
fenêtre Paramètres de l'application (Figure 3-1). 

Cliquez sur le menu Configuration en haut de la fenêtre du programme, puis sélectionnez Paramètres de  
l’application et spécifiez ou naviguez à un autre répertoire de destination. Lors que vous avez terminé, cliquez 
sur  le bouton OK pour confirmer et sauvegarder les paramètres. 

Figure 3-1 : Fenêtre des paramètres de l’application
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3.2.2 Paramètres de nom de fichier

À partir de la fenêtre Application Settings (Paramètres de l’application) dans le menu Configuration  
(Configuration), vous pouvez définir quels renseignements seront inclus dans les noms par défaut de vos  
fichiers de données téléchargées (voir Figure 3-1). Vous pouvez inclure la date de démarrage, la date de fin, la  
date de création, le numéro de série ou l’emplacement. Cochez les renseignements que vous souhaitez inclure. 

Lors que vous avez terminé, cliquez sur le bouton OK pour confirmer et sauvegarder les paramètres. 

3.2.3 Type par défaut des fichiers

À partir de la fenêtre Application Settings (Paramètres de l’application) dans le menu Configuration  
(Configuration), vous pouvez définir le type de fichier par défaut que vous souhaitez utiliser pour les fichiers de  
données téléchargés, sauvegardés et exportés. Les types de choix possibles sont *.xle (par défaut) et *.lev (voir  
Figure 3-1). Pour plus d’informations sur les deux types de fichiers, reportez-vous à la section 5.1.1. 

Vous avez également la possibilité de choisir entre le format nord-américain pour les nombres décimaux (un  
point au lieu d’une virgule) ou le format local du système, pour les fichiers *.csv exportés.  

Après avoir terminé les paramètres de l'application, cliquez sur le bouton OK pour confirmer et enregistrer 
les paramètres. 
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4 Programmation de l'enregistreur de données

Après avoir lancé le logiciel Levelogger, la fenêtre principale s’affiche, avec l’onglet Datalogger Settings  
(Paramètres de l’enregistreur) ouvert. Sélectionnez le périphérique approprié dans menu déroulant « Com  
Port » en haut de la fenêtre, dans la partie centrale. 

Cliquez sur pour récupérer les réglages actuels de l’enregistreur de données connecté.  

Remarque : Cliquez sur les icônes pour obtenir une explication de la fonction correspondante du logiciel.

Figure 4-1 : Onglet Datalogger Settings (Paramètres de l’enregistreur) - LevelVent 5

Figure 4-2 : Onglet Datalogger Settings (Paramètres de l’enregistreur) - AquaVent 5

Remarque : Après avoir récupéré les paramètres, si les piles de la tête de puits AquaVent Wellhead sont drainées à 20 % ou moins  
de leur charge, un message d’avertissement apparaît pour inviter l’utilisateur à remplacer les piles. 
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4.1 Paramètres de l’enregistreur de données

Une fois que vous avez récupéré les paramètres de configuration de l’enregistreur de données connecté, 
l’onglet  Datalogger Settings (Paramètres de l’enregistreur de données) permet d’identifier le type d’appareil, le 
numéro  de série, la ou les versions du microprogramme, le numéro d’identification du projet, l’emplacement, 
le niveau  de batterie et la configuration des voies.

•	 Instrument Type (Type d’instrument) : indique le modèle de l’enregistreur connecté, c.-à-d. : M5
•	 Numéro de série: le numéro de série unique de l'enregistreur connecté sera affiché. Si un AquaVent 
est connecté, le numéro de série de la tête de puits sera également affiché. 
•	 Versions du micrologiciel: affiche la version du firmware de l'enregistreur connecté. Si un 
AquaVent est  	 connecté, la version du micrologiciel de la tête de puits sera également affichée.
•	 Project ID (Numéro d’identification du projet) : saisissez le numéro de votre propre système  
d’identification. Le numéro d’identification du projet est limité à 32 caractères.
•	 Location (Emplacement) : saisissez des renseignements sur le site/l’emplacement spécifique.  
L’emplacement est limité à 32 caractères.

Les paramètres d'adresse et de débit en bauds MODBUS et SDI-12 sont uniquement destinés à être utilisés avec 
la connexion à 12 broches de la tête de puits. Voir les guides de l'utilisateur séparés pour les communications 
utilisant les protocoles MODBUS et SDI-12. 

4.1.1 Configuration des paramètres des voies

Dans la partie inférieure gauche de l’onglet Datalogger Settings (Paramètres de l’enregistreur) se trouve la 
zone  consacrée à la configuration des paramètres des voies (niveau, température). Après avoir récupéré les 
paramètres  de configuration de l’enregistreur, le logiciel détecte les voies disponibles.

4.1.1.1 Voie de niveau (Ch1)

•	 Identification décrit le paramètre de mesure du canal et a déjà été configuré comme 'LEVEL'. Le 
canal peut être renommé pour s'adapter à chaque projet. Les moniteurs de canal pression équivalente 
de la colonne d'eau. Le champ Identification sera l'en-tête du canal, la colonne de données titre et nom 
de la ligne du graphique lors de la visualisation des données. L'identification est limitée à 32 caractères.
•	 Unité fait référence à l'unité de mesure du canal. Il existe six options pour la mesure du niveau d'eau 
: m (par défaut), cm, ft, kPa, bar et psi. 

	 Remarque : Les relevés peuvent être convertis à d’autres unités en utilisant l’Assistant de données.

•	 Décalage fait référence à un ajustement, tel que la distance entre la pointe de l'enregistreur et le 
moniteur bouchon de puits ou niveau d'eau statique. Il est recommandé d'utiliser la valeur 0.00, car cela 
conserve tous les lectures ultérieures par rapport à la pointe de l'enregistreur. La plage de référence est 
de -300 m à 5000 m ou 1000 à 16.400 pi.

	 Noter: Les lectures peuvent être corrigées ou décalées par rapport à une élévation ou une référence spécifique pendant 
une spectre plus large de décalages numériques dans le cadre de l'assistant de données.

Figure 4-3 : Configuration d’une voie d’enregistreur de données
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4.1.1.2 Canal de température (Ch2)

•	 Identification décrit le paramètre de mesure du canal et a déjà été configuré comme 
« TEMPÉRATURE ». Le canal peut être renommé pour s'adapter à chaque projet. Le champ 
Identification sera être l'en-tête du canal, l'en-tête de la colonne de données et le nom de la ligne du 
graphique lors de l'affichage des données. L'identification est limitée à 32 caractères.
•	 Unité fait référence à l'unité de mesure du canal. Le canal de température peut être réglé sur °C (par 
défaut) ou ºF.

4.2 Informations sur l’enregistreur de données

La section Datalogger Information (Informations sur l’enregistreur de données) indique l’état de l’enregistreur  
de données connecté, à savoir : Les valeurs d’état possibles pour l’enregistreur de données sont : Started  
(Démarré), Stopped (Arrêté) ou Future Start (Démarrage programmé). Quand une valeur de démarrage ou  
d’arrêt est programmée, la valeur s’affiche dans le champ Future Start (Démarrage programmé) ou Stop  
time (Arrêt programmé) correspondant (voir section 4.9). Les champs se mettent à jour chaque fois que  
l’enregistreur de données est arrêté et redémarré.

Figure 4-4 : Informations sur l’enregistreur

4.3 Mémoire de l’enregistreur de données

La section Datalogger Memory (Mémoire de l’enregistreur de données) indique la quantité de mémoire utilisée  
et la quantité de mémoire disponible (nombre de relevés). 

Figure 4-5 : Quantité de mémoire disponible sur l’enregistreur

4.4 Durée de l'enregistreur de données

La section Datalogger Time (Horloge de l’enregistreur de données) fournit les outils pour régler l’horloge de  
l’enregistreur de données. Si vous souhaitez synchroniser l’horloge de l’enregistreur de données avec l’horloge  
de l’ordinateur, cliquez sur Synchronize (Synchroniser) pour régler l’heure de l’enregistreur de données. 

Si vous démarrez l’enregistreur de données sans synchroniser son horloge et que la différence de temps entre  
l’enregistreur de données et l’ordinateur est supérieure à 3 secondes, le logiciel affiche le message « Do you  
want to synchronize the logger time to system time? » (Souhaitez-vous synchroniser l’horloge de l’enregistreur  
à celle de votre système ?). Cliquez Yes (Oui) pour synchroniser l’horloge. 

Remarque : Pour synchroniser à une horloge différente ou à un fuseau horaire différent, vous devez d’abord régler l’horloge de  
l’ordinateur en utilisant le menu « Réglage de la date et de l’heure » du système d’exploitation Windows. Redémarrez ensuite le  
logiciel Solinst Levelogger, puis synchronisez vos enregistreurs à la nouvelle heure. 

Figure 4-6 : Horloge de l’enregistreur
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4.5 Mode d’échantillonnage de l’enregistreur

La section Datalogger Sampling Mode (Mode d’échantillonnage de l’enregistreur de données) vous permet de  
choisir le type d’échantillonnage pour les mesures. Les options possibles pour un LevelVent ou un AquaVent  
sont un échantillonnage linéaire, basé sur des événements ou programmé par l’utilisateur.

Le mode d’échantillonnage Linear (Linéaire) dénote un intervalle de temps fixe entre des séries de mesure  
successives. La fréquence d’échantillonnage peut être configurée sur toute valeur entre 0,125 seconde et  99 
heures. 

Remarque : L’autonomie typique des piles est de l’enregistreur LevelVent 5 est de 10 ans, en se basant sur 1 relevé par minute. Des  
prises de mesures plus fréquentes réduisent la durée de vie des piles. Par exemple, si un enregistreur LevelVent est configuré en  
mode Continuous (Continu) avec une fréquence d’échantillonnage de 1 seconde, les piles s’épuiseront après environ 4 mois.

Remarque : L’autonomie des piles est de l’AquaVent Wellhead est de 8 ans, en se basant sur 1 relevé par minute. Des prises de  
mesures plus fréquentes réduisent la durée de vie des piles. Par exemple, si un AquaVent est configuré en mode Continuous  
(Continu) avec une fréquence d’échantillonnage de 1 seconde, les piles s’épuiseront après environ 3 mois.

Figure 4-7 : Configuration du mode d’échantillonnage linéaire

Le mode d’échantillonnage Event Based (Basé sur des événements) est le moyen le plus efficace, du 
point  de vue de la mémoire, de collecter des données. En mode d’échantillonnage basé sur des événements,  
l’enregistreur de données est activé à chaque instant correspondant à la valeur de Sample Rate (Fréquence  
d’échantillonnage), afin de vérifier si les mesures ont changé par plus de la valeur de Change (Changement)  
depuis la dernière mesure enregistrée. 

« LEVEL » (Niveau) ou « TEMPERATURE » (Température) est la mesure faisant l’objet de la surveillance.  
L’enregistreur de données enregistre un nouveau relevé seulement si la mesure a changé par la valeur spécifiée,  
au point précis dans le temps, telle que définie par Sample Rate (Fréquence d’échantillonnage).

Remarque : En mode d’échantillonnage basé sur des événements, les enregistreurs LevelVent 5 et AquaVent 5 disposent 
d’une  mémoire totale de 60 000 relevés de niveau et de température. En mode d’échantillonnage basé sur des événements, les  
enregistreurs LevelVent et AquaVent disposent d’une mémoire totale de 24 000 relevés de niveau et de température.

Un relevé par défaut sera par ailleurs stocké dans la mémoire de l’enregistreur de données 24 heures après le  
dernier enregistrement si aucun « changement » ne s’est produit entre-temps.

Remarque : En mode d’échantillonnage Event Based (Basé sur des événements), la consommation des piles est principalement  
fonction de la fréquence d’échantillonnage. Par conséquent, avec une fréquence d’échantillonnage plus élevée, les piles s’épuisent  
plus rapidement, que les relevés soient enregistrés ou non.

Figure 4-8 : Configuration du mode d’échantillonnage basé sur des événements
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Le mode d’échantillonnage Schedule Sampling (Programmé par l’utilisateur) vous permet de sélectionner  
un programme d’échantillonnage de type logarithmique adapté aux besoins de chaque application. 

Le mode d’échantillonnage « Schedule » (Programmé par l’utilisateur) se configure en utilisant les boutons plus  
et moins pour ajouter ou soustraire des éléments dans la fenêtre Schedule (Calendrier de programmation).  
Le nombre maximum d’éléments dans un calendrier de programmation est de 30, chacun ayant sa propre  
fréquence d’échantillonnage en secondes, minutes, heures, jours ou semaines. Il est également possible de  
sélectionner « Pause » (Pause), ce qui arrête l’enregistrement de données pendant la durée spécifiée.

Remarque : Il est possible de sauvegarder un programme pour pouvoir l’appliquer à d’autres enregistreurs de données en  
sauvegardant le fichier de paramètres (voir section 4.7).

Le nombre total cumulé de relevés encore disponibles, le nombre total de relevés et le temps de fonctionnement  
cumulé sont affichés. Si le nombre de relevés sélectionné dépasse la capacité de mémoire de l’enregistreur, 
un  message d’erreur apparaît.  

Si vous cochez la case Repeat (Répéter), l’enregistreur de données répète le calendrier de programmation  
jusqu’à ce que la mémoire soit pleine ou jusqu’à ce qu’il soit arrêté.

Figure 4-9 : Configuration du mode d’échantillonnage programmé par l’utilisateur

4.6 Mode de mémoire de l’enregistreur de données

La sélection Memory Mode (Mode mémoire) du Datalogger n’apparaît que lorsque le mode d’échantillonnage  
Linear (Linéaire) est sélectionné. Lorsque vous utilisez un enregistreur de données en mode d’échantillonnage  
linéaire, vous avez le choix entre Continuous (Enregistrement continu) ou or Slate (Enregistrement sans  
recouvrement) .   

Les modes échantillonnage linéaire, basé sur des événements et programmé par l’utilisateur peuvent 
uniquement  utiliser l’option Slate (Enregistrement sans recouvrement). 

En mode d’enregistrement continu, le nouvel enregistrement sera lancé à la fin de n’importe quel 
enregistrement  précédent et continuera à enregistrer, finissant par enregistrer au-dessus des premières 
données enregistrées.  Comme l’une des options de téléchargement est « Append Data » (Ajouter les 
données), le mode d’enregistrement  continu peut constituer un bon choix pour les enregistrements de 
longue durée (voir section 5.1.2). 

En mode d’enregistrement sans recouvrement, le nouvel enregistrement est également lancé à la fin de  
n’importe quel enregistrement précédent, mais il s’arrête d’enregistrer après 150 000 (ou 40 000) relevés,  
sans jamais enregistrer les données actuellement enregistrées.

Figure 4-10 : Mode de mémoire de l’enregistreur
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4.7 Sauvegarde et récupération des fichiers de paramètres d’un enregistreur de données

Pour stocker les paramètres comme les valeurs par défaut, cliquez sur  . Cela stocke les paramètres de  
l’enregistreur de données dans un fichier *.dtf sous forme d’une série de valeurs par défaut. Le fichier *.dtf  
sauvegarde le numéro d’identification du projet, l’emplacement, le mode d’échantillonnage, la fréquence  
d’échantillonnage, le numéro de la voie, l’unité et le décalage. 

Pour récupérer des paramètres à partir des valeurs par défaut, cliquez sur à partir d’un fichier *.dtf.  
Cela est particulièrement utile lors de la programmation de plusieurs enregistreurs de données avec des  
paramètres similaires ou identiques. Gardez à l’esprit que le numéro d’identification du projet et l’identification  
de l’emplacement seront identiques et doivent être distinctes d’un enregistreur à l’autre ou d’un point de  
surveillance à l’autre.

4.8 Zéro de l’enregistreur de données

Avant de démarrer et de déployer votre enregistreur de données, vous pouvez le « mettre à zéro » à la pression  
atmosphérique actuelle. Cela permet de s’assurer qu’il indique 0 dans l’air pour la lecture de niveau. 

Remarque : Pour vérifier les lectures de votre enregistreur de données dans l’air, utilisez la fonction « Real Time View »  
(Visualisation en temps réel). Voir section 7.

Figure 4-11 : Zéro de l’enregistreur de données

Après avoir cliqué sur Zero (Zéro), l’heure actuelle est affichée sous « Last Zero Time » (Heure de la dernière  
mise à zéro). 

Remarque : Vous ne pouvez pas effectuer une mise à zéro d’un enregistreur de données tandis que celui-ci est en marche. 

Figure 4-12 : Heure de la dernière mise à zéro

Le zéro de l’enregistreur de données peut être effacé à l’aide de l’utilitaire de diagnostic. Voir section 10.
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4.9 Démarrage et arrêt de l’enregistreur de données

Démarrage de l’enregistreur de données

Il existe deux façons de démarrer l’enregistrement : Start Now (Démarrer maintenant) ou par programmation  
à Future Start (Démarrage programmé).

Pour commencer à enregistrer immédiatement, laissez le champ « Future Start » (Démarrage programmé)  
en blanc et cliquez sur . « Start Now » (Démarrer maintenant) devrait s’afficher en dessous de l’icône pour  
indiquer que l’enregistrement va démarrer immédiatement. 

Avant de démarrer un enregistreur de données LevelVent 5 ou AquaVent 5, une fenêtre contextuelle  
indiquera la quantité de mémoire disponible. Si vous sélectionnez « Yes » (Oui), le message est ignoré et  
l’enregistreur de données démarre immédiatement avec le reste de la mémoire disponible. Sélectionner « No 
»  (Non), vous donne la possibilité d’accéder à l’onglet Contrôle des données pour télécharger ou supprimer  
des fichiers de données à l’aide de l’option « Download Files » (Télécharger des fichiers), afin de libérer de la  
mémoire (voir section 5).

Lorsque vous commencez une nouvelle session 
d’enregistrement avec une version précédente  de 
LevelVent ou AquaVent, toutes les données de la session 
d’enregistrement précédente sont  effacées (reportez-vous à la 
section 5 pour le téléchargement de données).

Remarque : Si un paramètre a été modifié, il sera surligné en jaune, pour donner 
un rappel, avant que l’enregistreur de données  démarre. Si un paramètre a été 
configuré de manière incorrecte, il sera mis en évidence en rouge.

Figure 4-14 : Démarrage immédiat de l’enregistreur de données

Une fois que l’enregistreur de données a démarré et qu’il a commencé la collecte des mesures, l’icône Start  
(Démarrage) devient grisée et seuls l’icône Stop (Arrêt) et les paramètres de « Future Stop » (Arrêt programmé)  
sont actifs. 

Vérifier Future Start At (Démarrage programmé à) pour programmer l’enregistrement pour qu’il commence  
à une date ou une heure ultérieure. Ce mode de démarrage s’applique sous la forme Future Start (Démarrage  
programmé) dans le champ Status (État). Cliquez sur pour appliquer l’heure de démarrage programmé  
et tout autre changement apporté aux paramètres de l’enregistreur.

Lorsque l’heure de démarrage programmé est atteinte, l’enregistreur de données commence à enregistrer des  
mesures et son état passe de Future Start (Démarrage programmé) à Started (Démarré).

Remarque : Récupérez les paramètres de configuration de l’enregistreur de données afin d’actualiser l’état (c.-à-d. lorsque l’état  
change de « Future Start » (Démarrage programmé) à « Started » (Démarré)).

Figure 4-15 : Démarrage immédiat de l’enregistreur de données

Figure 4-13 : Avertissement de mémoire restante

Après avoir sélectionné « Yes » (Oui), tous les changements dans les valeurs des paramètres sont automatiquement  
appliqués à l’enregistreur de données et ce dernier commence à enregistrer. L’état de l’enregistreur passe de  
Stopped (Arrêté) à Started (Démarré). 
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Arrêt de l’enregistreur de données

Il existe deux manières d’arrêter l’enregistrement : Stop Now (Arrêter maintenant) l’enregistreur de données  
ou à un moment programmé dans l’avenir Future Stop (Arrêt programmé).

Pour arrêter l’enregistreur de données immédiatement tandis qu’il est en phase d’enregistrement, cliquez  
sur  , (« Stop Now » (Arrêter maintenant) devrait apparaître en dessous de l’icône)..

Il est possible d’arrêter l’enregistreur de données à tout moment avant qu’il n’atteigne sa capacité de lecture  
maximale. Démarrer à nouveau lance une nouvelle session d’enregistrement et efface les relevés  
stockés antérieurement.

Figure 4-16 : Arrêt immédiat de l’enregistreur de données

Pour programmer une heure d’arrêt de votre enregistreur de données dans le futur, cochez la case « Future  
Stop At » (Arrêt programmé à), puis en saisissant l’heure d’arrêt souhaitée. L’heure d’arrêt programmée sera  
appliquée à l’enregistreur de données une fois sélectionné pour un démarrage immédiat ou programmé.
. 

Vous pouvez également programmer une heure d’arrêt de votre enregistreur de données dans le futur en  
cochant la case « Future Stop At » (Arrêt programmé à) et en saisissant l’heure d’arrêt souhaitée. 
Sélectionnez  pour activer l’heure d’arrêt dans le futur (« Future Stop » (Arrêt programmé) devrait 
s’afficher sous  l’icône). 

Remarque : Si vous avez défini une heure d’arrêt dans le futur (« Future Stop » (Arrêt programmé), mais que vous souhaitez arrêter  
l’enregistreur immédiatement, désactivez la coche de la case « Future Stop At » (Arrêt programmé à) ; l’icône « Stop » (Arrêt) devrait  
alors changer pour « Stop Now » (Arrêter maintenant). Cliquez sur l’icône pour arrêter l’enregistrement.

L’heure d’arrêt doit être indiquée dans la section Datalogger Status (état de l’enregistreur).

Figure 4-17 : Configuration d’arrêt programmé

Il est essentiel de noter que lorsque l’enregistreur de données enregistre des données en mode Slate  
(Enregistrement sans recouvrement), cela signifie qu’il enregistre des mesures jusqu’à ce qu’il soit arrêté ou  
que sa mémoire soit pleine. Pour cette raison, il est important de déterminer, en fonction de votre heure de  
démarrage et de la fréquence d’échantillonnage, la date et l’heure à laquelle la mémoire sera pleine et que  
l’enregistreur de données arrêtera d’effectuer des enregistrements. L’enregistreur de données peut enregistrer  
en mode Slate (Enregistrement sans recouvrement) lorsque le mode d’échantillonnage est Event Based (Basé  
sur des événements) ou « Schedule » (Programmé par l’utilisateur). Le mode linéaire peut cependant être  
configuré pour un enregistrement continu ou sans recouvrement.
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5 Contrôle des données

Téléchargement et affichage des données à l’aide du logiciel Levelogger)

Cliquez sur l’onglet « Data Control » (Contrôle des données) depuis la fenêtre principale. À partir de l’onglet  
« Data Control » (Contrôle des données), vous pouvez télécharger les données d’un enregistreur de données,  
afficher les données sous forme de tableau ou de graphique, et sauvegarder ou exporter des fichiers de 
données.

Figure 5-1 : Onglet de contrôle des données

Cliquez sur  pour ouvrir un fichier *.xle ou *.lev. Il est possible d’ouvrir et de visualiser plusieurs fichiers 
en  même temps en cliquant sur l’onglet « File Name » (Nom des fichiers) en haut du tableau de données. 

Remarque : Lorsque vous cliquez sur un point du graphique, les données correspondantes sont mises en évidence dans le 
tableau.  Vous pouvez également sélectionner une section de données dans le graphique.

Tous les paramètres de l’enregistreur de données et les informations concernant la voie en vigueur lors de la 
prise  des mesures sont affichés en haut à gauche de la fenêtre. Les parties en bas à gauche de la fenêtre sont 
utilisées  pour afficher les informations après qu’une compensation des données a été effectuée, notamment 
les décalages  ou les conversions d’unités (voir section 6).

5.1 Options de téléchargement et fichiers de données de sauvegarde

5.1.1 Format de fichier par défaut

Le type de fichier par défaut pour le logiciel Levelogger, version 4 et plus récentes, est *.xle, à moins qu’il ne  
soit changé pour *.lev dans la fenêtre Application Settings (Paramètres de l’application) (voir section 3.2.3). 
Les  versions plus anciennes du logiciel Levelogger utilisaient des fichiers *.lev par défaut. Le type de fichier 
*.xle est  un format *.xml, qui permet des fonctionnalités perfectionnées. Les fichiers *.xle peuvent être 
exportés sous  forme de fichiers *.xml, intégrables dans des programmes de base de données externes.  

Remarque : Le type de fichier par défaut est *.xle, à moins qu’il ne soit changé dans la fenêtre Application Settings (Paramètres de  
l’application) (voir section 3.2.3).

Les fichiers *.lev de téléchargements antérieurs sont compatibles avec le logiciel Levelogger, version 4 et plus  
récentes, cependant, les fichiers *.xle ne sont pas compatibles avec les versions précédentes du programme. 
Pour  garantir la compatibilité, toutes les versions de logiciel Levelogger permettent d’exporter les données 
sous forme  de fichiers *.csv, utilisables dans des tableurs. Reportez-vous à la section 5.3 connaître les options 
d’exportation.
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5.1.2 Téléchargement de données

Avant de télécharger des données, vous devez sélectionner le port de communication auquel l’enregistreur de données est  

connecté et récupérer les paramètres de l’enregistreur connecté en cliquant sur dans l’onglet Datalogger Settings  
(Paramètres de l’enregistreur).

Cliquez sur  l’onglet « Data Control » (Contrôle des données) pour télécharger des données à partir d’un  
enregistreur de données connecté. Quatre options de téléchargement sont proposées.

Dans le cas des enregistreurs de données LevelVent 5 et AquaVent 5, ces options sont : « All Data » (Toutes  
les données), « Append Download » (Ajouter les données), « Partial Download » (Téléchargement  partiel) et « 
Download Files » (Télécharger des fichiers).. 

Dans le cas des enregistreurs de données LevelVent et AquaVent de modèles plus anciens, ces options 
sont :  « All Data » (Toutes les données), « Append Download » (Ajouter les données), « Partial Download »  
(Téléchargement partiel) et « Recover Previous Log » (Récupérer la session d’enregistrement précédente).

Si vous sélectionnez All Data (Toutes les données), le programme téléchargera toutes les données de la  
session d’enregistrement en cours d’un enregistreur de données dans un fichier *.xle. 

Le répertoire par défaut des données enregistrées se trouve dans le dossier "Data" : <C:\Program Files\
Solinst\Levelogger4_6\Data>. 

Si vous sélectionnez Append Download (Ajouter les données), le programme ajoutera les données dans un  
fichier *.xle ouvert de l’enregistreur de données. Le fichier *.xle ouvert et l’enregistreur de données connecté  
doivent avoir le même numéro de série et heure de démarrage, sans quoi une erreur se produit.

Figure 5-2 : Fenêtre de téléchargement partiel

Si vous sélectionnez Partial Download (Téléchargement partiel), une fenêtre de sélection pour 
téléchargement  partiel s’ouvre. Cette fenêtre affiche la date et l’heure de la première et du dernier relevé 
de la session  d’enregistrement. Utilisez le curseur pour sélectionner l’intervalle de temps correspondant aux 
données que  vous souhaitez. Lorsque vous cliquez sur OK, toutes les données à l’intérieur de cet intervalle de 
temps sont  téléchargées dans un fichier *.xle. 

Dans le cas des enregistreurs de données LevelVent 5 et AquaVent 5, si vous sélectionnez “Download  Files” 
(Télécharger des fichiers), le logiciel affiche une fenêtre avec une liste des sessions d’enregistrement  
actuellement stockées dans la mémoire de l’enregistreur de données. Sélectionnez les fichiers que 
vous  souhaitez télécharger. Chaque session d’enregistrement sera enregistrée dans un fichier * .xle 
distinct. 
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Figure 5-4 : Message d’erreur d’écriture  de 
fichier

Pour accéder à la mémoire complète, sélectionnez « Delete All Files » (Supprimer tous les fichiers). Un  
message d’avertissement « Warning All Data in the logger will be erased! Continue? » (Toutes les données de  
l’enregistreur seront effacées ! Continuer ?) s’affiche. Sélectionnez « Yes » (Oui) ou « No » (Non) pour continuer.  
(La sélection de fichiers individuels à supprimer n’est pas une option.) Cela permet de libérer de la mémoire  
avant de démarrer un enregistreur de données Levelogger série 5 (voir section 4.9).

Figure 5-3 : Télécharger la liste des fichiers

Dans le cas des enregistreurs de données LevelVent et AquaVent de modèles plus anciens, si vous sélectionnez  
Recover Previous Log (Récupérer la session d’enregistrement précédente), le logiciel va essayer de récupérer  
les données de la session d’enregistrement précédente et les télécharger dans un fichier *.xle.

Une fois les données téléchargées à partir d’un enregistreur de données, elles sont automatiquement  
sauvegardées dans un fichier temporaire.  

5.1.3 Sauvegarde des données

Cliquez sur pour sauvegarder les données dans un fichier *.xle. 

Le répertoire par défaut des données enregistrées se trouve dans le dossier "Data" : <C:\Program Files\
Solinst\Levelogger4_6\Data>. 

Toutefois, il est possible de modifier le répertoire par défaut pour la 
sauvegarde  des fichiers en cliquant sur le menu Configuration (Configuration) 
en haut  de la fenêtre du programme, puis en sélectionnant Application 
Settings  (Paramètres de l’application) et en spécifiant ou en naviguant à 
un autre  répertoire. Si une erreur est rencontrée lors de la sauvegarde du 
premier  fichier de données, comme illustré sur la Figure 5-4, il est possible 
que vous  n’ayez pas les privilèges d’écriture de fichiers dans le répertoire par 
défaut. Dans ce cas, créez un nouveau  répertoire dans le répertoire « Mes 
Documents » et configurez-le comme le répertoire de sauvegarde par  défaut. 
Essayez alors à nouveau de sauvegarder vos fichiers.
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5.2 Fonction de manipulation et de zoom de graphiques

Pour effectuer un zoom avant sur le graphique, cliquez sur . 

Pour effectuer un zoom arrière sur le graphique, cliquez sur  . Cliquez sur  pour annuler toutes les  
fonctions de zoom.

Les fonctions de zoom sont également utilisables avec les sélections de données dans le graphique.

Remarque : Cliquez sur le bouton droit, puis faites glisser la souris pour analyser le graphique de données.

Cliquez sur pour ouvrir la boîte de dialogue des options du graphique. La boîte de dialogue des options  
du graphique est illustrée sur la Figure 5-5.

Figure 5-5 : Fenêtre des options de lignes

L’onglet « Line Option » (Options de lignes) est utilisé pour ajuster le style et la couleur de la ligne de chaque  
voie sur le graphique. L’utilisateur peut également choisir la forme des marques de données ou supprimer les  
marques de données.

Figure 5-6 : Fenêtre des options d’axe et de titre

L’onglet « Title and Axis Option » (Option d’axe et de titre) est utilisé pour saisir le titre du graphique et  
modifier l’étiquette de l’axe des ordonnées ou sélectionner une échelle définie par l’utilisateur. Cochez la case  
« Best Fit » (Ajustement optimal) pour laisser le logiciel déterminer l’ajustement optimal de l’échelle. Si la case  
« Best Fit » (Ajustement optimal) n’est pas cochée, l’utilisateur doit saisir une valeur minimale et une valeur  
maximale pour la voie sélectionnée. L’axe des abscisses représente l’heure d’enregistrement.
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Il existe une option d’affichage des graphiques sous forme « Combined Plot » (Graphes combinés) ou « 
Separated  Plot » (Graphes séparés). L’option « Combined Plot » (Graphes combinés) affiche les données 
de chaque voie  sur un même graphe. L’option « Separated Plot » (Graphes séparés) affiche les données de 
chaque voie sur  un graphe séparé. 

Figure 5-7 : Graphes combinés et graphes séparés

Il existe également une option pour afficher plusieurs graphes à la fois. Cliquez sur un onglet de nom de fichier  
et faites-le glisser, puis déposez-le lorsque vous voyez une zone d’ombre sur la fenêtre pour ouvrir un graphe  
séparé de ce fichier de données. Il n’y a pas de limite sur le nombre de graphes que vous pouvez afficher en  
même temps. Redimensionnez votre fenêtre au besoin.

Figure 5-8 : Affichage de deux graphes
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5.3 Fonction d’exportation de fichier et d’impression

Il est possible d’exporter les données au format *.csv (valeurs séparées par des virgules) ou au format *.xml  
(extensible markup language) en cliquant sur File > Export > Data ou sur 

Les formats de fichiers *.csv et *.xml sont pris en charge et peuvent être importés par la plupart des tableurs  
et des programmes de bases de données.

Par ailleurs, les graphiques de données peuvent être exportés en format *.bmp ou *.png en cliquant sur File  
> Export > Graph. 

Les paramètres de l’enregistreur, le tableau de données et les graphiques de données peuvent être imprimés.  
Cliquez sur File > Print Preview (Fichier > Aperçu avant impression) pour ouvrir la fenêtre d’aperçu avant  
impression. La Figure 5-9 montre l’aperçu avant impression des paramètres de l’enregistreur. Les paramètres  
de l’enregistreur sont toujours sur la première page du document. Le graphique de données se trouve sur la  
deuxième page du document, tandis que le reste du document contient le tableau des données. 

Cliquez sur « Print… » (Imprimer) pour ouvrir la boîte de dialogue d’impression. Vous pouvez choisir d’imprimer  
le document en entier ou seulement une partie. Vous pouvez également cliquer sur File > Print (Fichier >  
Aperçu), pour ouvrir la boîte de dialogue d’impression.

Figure 5-9 : Écran d’aperçu avant impression
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6 Compensation des données

Il est possible d’effectuer automatiquement une compensation des données, comme un ajustement manuel des  
données ou un ajustement des paramètres, en utilisant l’Assistant de données du logiciel, ou manuellement, en  
exportant les données vers un tableur.

6.1 Assistant de données

Ouvrez l’onglet « Data Wizard » (Assistant de données). La première étape consiste à sélectionner le chemin  
pour la compensation de vos données. Sur un enregistreur LevelVent 5 ou AquaVent 5, seule l’option  « 
Advanced » (Avancée) est disponible. 

Remarque : Il est possible de compenser plusieurs fichiers de données à la fois.

L’option Advanced (Avancée) permet d’effectuer des ajustements manuels des données ou des ajustements  
des paramètres.

Figure 6-1 : Assistant de données

Manual Data Adjustments (Ajustements manuels des données) permet de saisir une mesure manuelle du  
niveau d’eau ou un point de référence comme valeur représentant le zéro. Tous les relevés de niveau d’eau  
sont alors ajustés relativement à cette valeur. Il existe une option pour convertir les mesures en « Depth to  
Water Level » (Profondeur jusqu’au niveau de l’eau) (p. ex., depuis le haut d’un tubage de puits jusqu’au niveau  
de l’eau) ou « Elevation of Water Level » (Altitude du niveau d’eau) (p. ex. au-dessus du niveau de la mer).

Remarque : L’ajustement manuel des données et l’ajustement des paramètres sont des fonctions utiles pour corriger des fichiers  
de données, afin de rendre les relevés homogènes au sein d’un même projet.  

Parameter Adjustments (Ajustements des paramètres) permet de convertir les données à des unités de  
mesure différentes, d’ajouter un décalage ou d’ajuster la densité.

•	 Unité La conversion vous permet de convertir les lectures de niveau dans un fichier de données en 
différentes unités (m, cm, ft, kPa, bar ou psi), ou des lectures de température à ºC ou ºF,
•	 Décalage vous permet d'entrer n'importe quelle valeur, positive ou négative, qui sera ajoutée à 
chaque lecture  	dans le fichier de données sélectionné à compenser de ce montant. Il est recommandé 
de rester avec le zéro par défaut  	valeur, sauf si un décalage connu a été déterminé (par exemple 
pour corriger la dérive du capteur de pression. Voir •in technique Solinst : Comprendre l'exactitude, la 
précision, la résolution et la dérive des capteurs de pression.
•	 Ajustement de la densité corrige la plage du canal de niveau dans le fichier de données en fonction 
d'une entrée utilisateur  	 réglage de la densité du fluide. La plage de réglage de la densité est de 0,9 
kg/L à 1,1 kg/L.
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Lorsque vous sélectionnez une compensation Advanced (Avancée), la fenêtre Data Compensation Options  
(Options de compensation des données) s’ouvre. 

Figure 6-2 : Options de compensation des données

Tout d’abord, vous devez sélectionner la manière dont vous voulez que vos données soient affichées, « Manual  
Data Adjustments » (Ajustements manuels des données) :

•	 Profondeur jusqu'au niveau de l'eau ajuste les données de niveau d'eau pour représenter les 
lectures de profondeur par rapport au niveau d'eau (à partir du sommet d'un tubage de puits ou autre 
point de référence) en entrant un zéro de champ, tel qu'une profondeur manuelle à mesure du niveau 
d'eau. Des ajustements peuvent être apportés à un ou plusieurs fichiers de données. 
•	 Élévation du niveau de l'eau ajuste les données de niveau d'eau pour représenter l'élévation des 
lectures de niveau d'eau  	(au-dessus du niveau de la mer ou d'un autre point de référence) en entrant une 
altitude de point de mesure, et un champ zéro, comme une mesure de jauge à partir de ce point. Des 
ajustements peuvent être apportés à une ou plusieurs données des dossiers.
•	 Réglages des paramètres uniquement vous permet d'ajuster un ou plusieurs fichiers de données à 
différentes unités, densité, etc., tout en gardant le diaphragme du capteur (point zéro) comme point de 
référence pour l'enregistreur de données.

Sélectionnez ensuite Yes (Oui) ou No (Non) pour effectuer des ajustements des paramètres sur les fichiers  de 
données. Cette option n’est pas active si vous avez sélectionné Parameter Adjustments Only (Ajustements  des 
paramètres uniquement)..

Après avoir sélectionné toutes les options de compensation de données souhaitées, cliquez sur Next (Suivant). 
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Dans la fenêtre suivante, vous devez choisir les fichiers de données auxquels vous souhaitez appliquer la  
compensation. Tous les fichiers ouverts dans l’onglet « Data Control » (Contrôle des données) figurent sur  la 
liste. 

Utilisez le répertoire sur la gauche de la fenêtre, ou cliquez sur  , pour ouvrir d’autres fichiers de données  
auxquels vous souhaitez appliquer la compensation. Vérifiez que les fichiers auxquels vous souhaitez appliquer  
la compensation sont en surbrillance dans la liste. Pour ce faire, cliquez sur le nom du fichier. Pour désélectionner  
un fichier, cliquez à nouveau dessus. Cliquez sur Next (Suivant) pour continuer.

Figure 6-3 : Sélection des fichiers auxquels appliquer la compensation

Si vous avez sélectionné Yes (Oui) pour Parameter Adjustments (Ajustements de paramètres) ou si vous avez  
sélectionné l’option Parameter Adjustments Only (Ajustements des paramètres uniquement), vous devez  
saisir les valeurs des paramètres dans la fenêtre suivante. Si vous n’avez pas sélectionné l’ajustement des  
paramètres, cette fenêtre n’apparaît pas..

Remarque : Lors d’un changement d’unité, si vous sélectionnez de l’appliquer à toutes les données, le même changement d’unité  
sera appliqué à tous les fichiers soumis à la compensation en cours.

Figure 6-4 : Ajustement des paramètres
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Ensuite, pour chaque fichier de données sélectionné, vous devez saisir les valeurs représentant le zéro que vous  
souhaitez utiliser pour ajuster manuellement les données de niveau d’eau. (Si vous avez sélectionné l’option  
Parameter Adjustments Only (Ajustements des paramètres uniquement), cette fenêtre n’apparaît pas.)

Pour les ajustements Depth to Water Level (Profondeur jusqu’au niveau de l’eau), saisissez une valeur pour  A 
= Field Zero (Valeur représentant le zéro). Si le niveau statique de l’eau est inférieur à la valeur représentant  
le zéro, la valeur représentant le zéro est saisie comme une valeur positive (p. ex. une mesure manuelle du  
niveau d’eau effectuée depuis le haut du tubage de puits. Voir Exemple 6.1). Si le niveau statique de l’eau est  
supérieur à la valeur représentant le zéro, la valeur représentant le zéro est saisie comme fluide dans valeur  
négative (comme dans un puits artésien fluide dans une tête de puits scellée)..

La date et l’heure auxquelles la mesure de la valeur représentant le zéro a été prise doit remplacer un relevé  
actuel dans le fichier de données. Cette valeur est sélectionnée dans le menu déroulant montrant toutes les  
estampilles temporelles dans le fichier de données. Cliquez sur « Add » (Ajouter) pour appliquer l’ajustement.  
Si vous avez besoin de modifier la valeur représentant le zéro, cliquez sur « Update » (Mettre à jour) après toute  
modification.

Remarque : La date et l’heure de la mesure de la valeur représentant le zéro doivent être enregistrées pour terminer l’ajustement.  
La valeur représentant le zéro doit remplacer un relevé actuel dans le fichier de données, c.-à-d., effectuez une mesure manuelle  
immédiatement après le démarrage de l’enregistreur de données, puis notez la date et l’heure. 

Figure 6-5 : Ajustement manuel des données - Profondeur jusqu’au niveau de l’eau



Guide de l'utilisateur des enregistreurs 
de données ventilés

Page 43

Exemple 6.1 : Ajustement de la profondeur jusqu’au  niveau de 
l’eau

Lorsque vous utilisez une mesure manuelle de la profondeur jusqu’au niveau de  
l’eau effectuée depuis le haut d’un tubage de puits comme valeur représentant le  
zéro, saisissez cette valeur comme un nombre positif (p. ex. 10 m). 

Dans votre fichier de données ajustées, les valeurs de vos relevés augmenteront  
lorsque le niveau d’eau diminue. C’est parce que la profondeur jusqu’au niveau  
statique de l’eau depuis le haut du tubage du puits augmente. Les valeurs des  
relevés ajustés diminuent lorsque le niveau statique de l’eau augmente.

Données d’origine
(hauteur de l’eau au-dessus du  
capteur)

8.75 m 8.50 m 8.75 m 9.5 m 9.75 m

Données ajustées (profondeur  
jusqu’au niveau de l’eau)

A) 10.0 m 10.25 m 10.0 m 9.25 m 9.0 m
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Pour les ajustements Elevation of Water Level (Altitude du niveau d’eau), saisissez une valeur pour  A 
= Measuring Point Elevation (Altitude du point de mesure) et une valeur pour B = Field Zero (Valeur  
représentant le zéro) à partir de ce point de mesure. 

Si le niveau statique de l’eau est inférieur au point de mesure, la valeur représentant le zéro est saisie comme  
une valeur positive (p. ex. si vous utilisez une mesure manuelle de la profondeur jusqu’au niveau de l’eau  
comme valeur représentant le zéro, depuis le haut du tubage de puits comme point de mesure.

Si le niveau statique de l’eau est supérieur au point de mesure, la valeur représentant le zéro est saisie comme  
pulvérisation valeur négative (comme dans un puits artésien fluide dans une tête de puits scellée). Il est possible  
de saisir une valeur négative comme altitude du point de mesure.

Figure 6-6 : Ajustement manuel des données - Altitude de l’eau

La date et l’heure auxquelles la mesure de la valeur représentant le zéro a été prise doit remplacer un relevé  
actuel dans le fichier de données. Cette valeur est sélectionnée dans le menu déroulant montrant toutes les  
estampilles temporelles dans le fichier de données. Cliquez sur « Add » (Ajouter) pour appliquer l’ajustement.  
Si vous avez besoin de modifier la valeur représentant le zéro, cliquez sur « Update » (Mettre à jour) après toute  
modification.

Remarque : La date et l’heure de la mesure de la valeur représentant le zéro doivent être enregistrées pour terminer l’ajustement.  
La valeur représentant le zéro doit remplacer un relevé actuel dans le fichier de données. c.-à-d. effectuez une mesure manuelle  
immédiatement après le démarrage de l’enregistreur de données, puis notez la date et l’heure. 

Vous pouvez effectuer plusieurs ajustements sur un même fichier de données en sélectionnant à nouveau  « 
Add » (Ajouter) pour saisir une autre valeur représentant le zéro. Toutes les mesures effectuées après cette  
date et heure seront ajustées en fonction de cette deuxième mesure. Vous pouvez ajouter autant d’ajustements  
à un même fichier de données que vous le souhaitez (du moment que cela ne dépasse pas le nombre total de  
mesures dans ce fichier).

Cliquez sur Next (Suivant) pour terminer la compensation. 



Guide de l'utilisateur des enregistreurs 
de données ventilés

Page 45

Les données compensées seront automatiquement enregistrées dans un nouveau fichier *.xle. Le nom de 
fichier par défaut sera le avec le mot <compensé> ajouté au préfixe du nom de fichier. L'utilisateur peut 
également renommer le fichier compensé en l'enregistrant dans l'onglet Contrôle des données. Ne pas modifier 
ou supprimer l'extension du fichier. Tous les fichiers de données sont enregistrés à l'emplacement par défaut : 
<C:\Program Files\Solinst\Levelogger4_6\Data>.

Remarque : Tous les fichiers de données sont sauvegardés dans le répertoire par défaut : <C:\Program Files\Solinst\  
Levelogger4_6\Data>. Toutefois, il est possible de modifier le répertoire par défaut pour la sauvegarde des fichiers en cliquant  
sur le menu Configuration (Configuration) en haut de la fenêtre du programme, puis en sélectionnant Application Settings  
(Paramètres de l’application) et en spécifiant ou en naviguant à un autre répertoire. 

La fenêtre suivante montre les résultats de la compensation. Si la compensation n’a pas réussi, une explication  
est fournie dans la colonne « Reason » (Raison). Vous pouvez toujours visualiser le fichier compensé dans  
l’onglet « Data Control » (Contrôle des données) en cliquant sur « Open » (Ouvrir) dans la colonne « Action 
»  (Action). Si la compensation est réussie, cliquez sur « Open » (Ouvrir) pour afficher le fichier des données  
compensées dans l’onglet « Data Control » (Contrôle des données). 

Figure 6-7 : Résultats de la compensation des données

Si vous avez sélectionné plusieurs fichiers pour la compensation, vous aurez également la possibilité d’”ouvrir 
tous” les fichiers compensés dans l’onglet Contrôle des données ou d’”exporter tous” les fichiers compensés 
en même temps. Les options sont d’exporter en tant que fichiers *.csv ou *.xml.

Figure 6-8 Résultats de la compensation des données - Fichiers multiples
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À partir de l’onglet « Data Control » (Contrôle des données), vous pouvez afficher les données, sauvegarder le  
fichier compensé avec un nouveau nom de fichier ou exporter les données (voir section 5).

Tous les paramètres d’origine de l’enregistreur de données et les informations concernant la voie en vigueur  
lors de la prise des mesures sont affichés en haut à gauche de la fenêtre. Les parties en bas à gauche de la  
fenêtre sont utilisées pour afficher les informations sur la compensation. 

Illustration 6-9 Visualisation des fichiers compensés dans l’onglet Contrôle des données
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7 Visualisation en temps réel

Cliquez sur l’onglet « Real Time View » (Visualisation en temps réel) de la fenêtre principale (voir Figure 7-1). Le  
rôle de cet onglet est de fournir une mesure à l’écran des données enregistrées par l’enregistreur de données  
connecté. Les données seront présentées sous forme de tableau et de graphique. Toutes les informations sur  
la voie et les paramètres de configuration de l’enregistreur de données sont affichés sur la gauche de la fenêtre.  

Tout d’abord, sélectionnez une fréquence d’affichage sans enregistrement  . La fréquence  
d’affichage peut être configurée de manière indépendante de la période d’enregistrement de l’enregistreur de  
données et n’interfère pas avec les enregistrements effectués par l’enregistreur LevelVent 5 ou AquaVent 5  
lui-même.

Cocher Enable Manual Data Adjustment (Permettre l’ajustement manuel des données) permet de saisir une  
valeur représentant le zéro/un référentiel (p. ex. la profondeur jusqu’au niveau de l’eau) utilisée pour ajuster  
les relevés pour la visualisation en temps réel. Cette fonction n’est disponible que lorsque vous effectuez des  
relevés en m, cm ou ft..

Les paramètres de l’enregistreur ne peuvent pas être modifiés dans l’onglet « Real Time View » (Visualisation en temps réel). Les  
modifications doivent être effectuées dans l’onglet Datalogger Settings (Paramètres de l’enregistreur). Les modifications sont  
appliquées lorsque les relevés en temps réel sont démarrés.

Les relevés visualisés en temps réel peuvent être affichés sous forme de graphique ou sous forme de tableau.  
Les mêmes options sont disponibles pour le graphique des relevés visualisés en temps réel que dans l’onglet  
« Data Control » (Contrôle des données). Les relevés visualisés en temps réel sont enregistrés par le logiciel  
Levelogger et il est possible, avant de fermer la fenêtre, de les sauvegarder en exportant les données dans un  
fichier *.csv, en cliquant sur l’option d’exportation de fichier .

Pour démarrer les relevés actuels, cliquez sur  . Les relevés s’affichent immédiatement.  

Pour effectuer un relevé à tout moment, cliquez sur  le bouton et le relevé sera ajouté aux données  
affichées. Pour désactiver la visualisation en temps réel, décidez si vous souhaitez sauvegarder les données  
comme décrit ci-dessus, puis cliquez sur  .

Figure 7-1 : Fenêtre de visualisation en temps réel
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8 Installation d’un enregistreur de données ventilé

8.1 Installation d’un LevelVent

Le système LevelVent 5 est conçu pour être facilement installé sur un tubage de puits de 5 cm (2 pouces),  
ou 10 cm (4 pouces) en utilisant un adaptateur. Cependant, d’autres installations sont acceptables si des  
précautions adéquates sont prises et les recommandations sont suivies. 

La tête de puits LevelVent Wellhead a un indice de protection IP64 (résistantes à la poussière et aux  
éclaboussures) et ne doit donc jamais être immergée. Il est possible de la fixer à l’intérieur d’un boîtier, mais  
dans ce cas, le boîtier doit être ventilé pour égaliser la pression atmosphérique. La tête de puits Wellhead  
mesure 30 x 76 mm (1,2 x 3,0 pouces).  

Commencez par vous assurer que vous avez connecté correctement votre enregistreur LevelVent 5 au  
câble ventilé, et le câble ventilé à la tête de puits. Reportez-vous à la section 1.5.1 pour les instructions de  
raccordement. Reportez-vous à la section 8.1.1 pour l’installation en utilisant l’ensemble de couvercle de puits  
de 5 cm (2 pouces) et le support de suspension.

8.1.1 Installation d’un LevelVent dans un puits de 5 cm (2 pouces)

Chaque tête de puits LevelVent Wellhead est fournie avec un support de suspension et un ensemble de  
couvercle de puits de 5 cm (2 pouces), qui se compose d’un insert, d’une base de couvercle de puits et d’un  
couvercle de puits. 

L’insert de l’ensemble de couvercle de puits de 5 cm (2 pouces) a deux ouvertures qui peuvent être utilisées 
pour  installer et soutenir une tête de puits LevelVent Wellhead. La deuxième ouverture peut alors être 
utilisée pour  effectuer des mesures manuelles du niveau de l’eau tandis que l’enregistreur LevelVent 5 fait ses 
enregistrements  au fond du puits. Deux bouchons rouges sont fournis pour lorsque les ouvertures ne sont 
pas utilisées.

Remarque : Un troisième trou d’accès de 18 mm (0,7 pouce) permet d’installer un équipement de surveillance supplémentaire  
dans le puits, comme une sonde de mesure du niveau d’eau pour les mesures manuelles sur le terrain.  

Remarque : Pour les têtes de puits de 10 cm (4 pouces), un adaptateur séparé est disponible pour l’utiliser sur une base du  
couvercle de puits de 5 cm (2 pouces).

Adaptateur

Casquette

Base

Insérer

Bouchons

Support de 
suspension

Figure 8-1 : Ensemble de couvercle de puits de 5 cm (2 pouces), adaptateur et support de suspension
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Les étapes ci-dessous montrent comment installer le LevelVent en utilisant le support de suspension et  
l’ensemble de couvercle de puits de 5 cm (2 pouces) :

Raccordez le câble ventilé à la tête de puits et à l’enregistreur LevelVent 5. Reportez-vous à la section 1.5.1 pour plus de détails.

Remarque : À des fins de diagnostic, vous pouvez installer l’extrémité du câble ventilé portant le numéro de série au connecteur  
de surface de la Wellhead. 

Faites glisser la base du couvercle du puits sur le tubage de puits. Ne la fixez pas pour l’instant.   

Placez le support de suspension dans la base du couvercle du puits de manière à ce qu’il repose sur l’épaulement dans la base.  Placez l’insert dans la même 
base du couvercle du puits.

Remarque :Il existe trois trous dans la partie supérieure du support de suspension qui peuvent être utilisés pour le fixer dans la  
base du couvercle du puits avec des vis. 
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Retirez l’un des bouchons rouges de l’insert. Abaissez l’enregistreur LevelVent 5 et le câble ventilé par l’ouverture puis dans le puits,  jusqu’à ce que la 
tête de puis repose sur l’insert. Retirez l’autre bouchon rouge de l’insert et effectuez une mesure manuelle de la  profondeur jusqu’au niveau de l’eau 

pour vos dossiers.

Soulevez la base du couvercle de puits avec le support de suspension et l’insert du tubage du puits. Enroulez le câble ventilé autour  du support de 
suspension, puis faites-le glisser dans les encoches pour fixer le câble au support. 

Remarque : Les trous dans le support peuvent accueillir des attaches mono-usage et des serre-câbles pour fixer le câble au  
support si vous le souhaitez. 

Rabaissez l’ensemble de couvercle de puits sur le tubage de puits. Fixez la base du couvercle du puits sur le tubage de puits si  vous le souhaitez. 
Installez le couvercle du puits.  Remarque : il est possible que vous ayez besoin de retirer le bouchon anti-poussière de la tête de puits 

LevelVent Wellhead avant  d’installer le couvercle de puits.. 

Figure 8-2 2 : Installation en utilisant un ensemble de couvercle de puits et un support de suspension
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8.2 Installation d’un AquaVent

Le système AquaVent 5 est conçu pour être facilement installé sur un tubage de puits de 5 cm (2 pouces), 
ou  10 cm (4 pouces) en utilisant un adaptateur. Cependant, d’autres installations sont acceptables si des 
précautions  adéquates sont prises et les recommandations sont suivies. 

Remarque :Songez à utiliser une tête de puits de protection étendue de style à couvercle supérieur. Cela vous offrirait un accès  
complet aux composants de l’AquaVent Wellhead en haut du puits de surveillance. 

Les têtes de puits AquaVent Wellhead ont un indice de protection IP64 (résistantes à la poussière et aux  
éclaboussures) et ne doivent donc jamais être immergées. Il est possible de les fixer à l’intérieur d’un boîtier, 
mais  dans ce cas, le boîtier doit être ventilé pour égaliser la pression atmosphérique. La tête de puits Wellhead 
mesure  102 x 140 mm (4,0 x 5,5 pouces). 

Assurez-vous de connecter correctement votre enregistreur AquaVent 5 au câble ventilé, et le câble ventilé à  
la tête de puits. Reportez-vous à la section 1.5.1 pour les instructions de raccordement. Reportez-vous à la  
section 8.2.2 pour l’installation en utilisant la base du couvercle du puits et le support de suspension.

8.2.1 Installation des piles d’une tête de puits AquaVent Wellhead

Remarque : Après avoir récupéré les paramètres dans le logiciel Levelogger, si les piles de la tête de puits Wellhead sont drainées  
à 20 % ou moins de leur charge, un message d’avertissement apparaît pour inviter l’utilisateur à remplacer les piles. 

Chaque tête de puits Wellhead utilise quatre (4) piles au lithium AA de 1,5 V remplaçables. Pour installer les 
piles, suivez les étapes ci-dessous :

1.	 Dévissez le couvercle de la tête de puits pour accéder au compartiment des piles. 

2.	 Retirez avec précaution le porte-piles du compartiment. 

3.	 Installez les quatre piles dans le support. Assurez-vous de la bonne polarité lors de la mise en place des piles, en 
faisant attention à la symboles positifs {+} et négatifs {-} gravés dans le support.  

4.	 Faites glisser le support de batterie dans le compartiment. Assurer un bon alignement ; les contacts à ressort 
dans le le boîtier doit être aligné avec les contacts saillants au bas du support de batterie. 

5. 	 Revissez le couvercle supérieur fermement sur la tête de puits. 

6.	 Après avoir remplacé les piles, pour réinitialiser l'indicateur de batterie dans le logiciel Levellogger, utilisez 
l'utilitaire de diagnostic (voir la section 10.6). 

Figure 8-3 : Installation des piles dans la tête de puits

Fréquence d’échantillonnage de 
l’AquaVent Estimation de l’autonomie des piles

8 relevés par seconde 10 jours

1 relevé par seconde 3 mois

1 relevé par minute 8 ans

8.2.1.1 Estimations de l’autonomie des piles d’une tête de puits Wellhead
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8.2.2 Installation d’un AquaVent dans un puits de 5 cm (2 pouces)

Le support de suspension est utilisé pour fixer le câble ventilé à la tête de puits lors du déploiement. 

Le système de support est composé de la base du couvercle de puits de 5 cm (2 pouces) et du support de  
suspension (tous deux fournis avec la tête de puits). Pour les têtes de puits de 10 cm (4 pouces), un adaptateur  
est disponible pour l’utiliser sur une base du couvercle de puits de 5 cm (2 pouces).

Remarque : Un ensemble de couvercle de puits de 5 cm (2 pouces) est fourni avec chaque tête de puits AquaVent Wellhead.  
Seule la base de l’assemblage est nécessaire pour installer le support de suspension. Le couvercle pourra être utilisé plus tard pour  
sceller un puits, si la tête de puits AquaVent Wellhead est retirée.

Installez la base du couvercle du puits sur le tubage de puits.  

Les étapes ci-dessous montrent comment installer l’AquaVent en utilisant le support de suspension dans un  
puits de 5 cm (2 pouces) :

Adaptateur

Casquette

Base

Support de 
suspension

Figure 8-4 : couvercle de puits et base, adaptateur et support de suspension
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Enroulez l’extrémité supérieure du câble ventilé autour du support de suspension, puis insérez-le dans les encoches pour fixer le  câble au support. Laissez environ 5 cm 
(2 po) de mou dans le câble au-dessus du support de suspension. 

Remarque : Laissez suffisamment de mou dans le câble ventilé à la surface pour pouvoir soulever l’AquaVent Wellhead de la  base du 
couvercle du puits, afin d’accéder à la connexion du câble ventilé ou d’effectuer une mesure manuelle de la profondeur  jusqu’au niveau de 
l’eau, sans perturber l’enregistreur AquaVent 5 de sa position au fond du trou.

Remarque : Les trous dans le support peuvent accueillir des attaches mono-usage et des serre-câbles pour fixer le câble au  support si 
vous le souhaitez. 
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Raccordez l’autre extrémité du câble ventilé à l’enregistreur AquaVent 5. Reportez-vous à la section 1.5.1 pour plus de détails.  Abaissez le câble ventilé muni 
de l’enregistreur dans le puits.

Remarque : À des fins de diagnostic, vous pouvez installer l’extrémité du câble ventilé portant le numéro de série au connecteur  de surface de la tête 
de puits Wellhead. 

Abaissez le support de suspension dans le puits jusqu’à ce qu’il repose sur l’épaulement dans la base du couvercle du puits. 

Remarque : Il existe trois trous dans la partie supérieure du support de suspension qui peuvent être utilisés pour le fixer dans la  
base du couvercle du puits avec des vis. 
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Poussez avec précaution l’excédent de câble ventilé dans le puits. Vissez la tête de puits Wellhead sur la base du couvercle du  puits jusqu’à ce qu’elle repose 
bien sur l’épaulement.

Remarque : Laissez suffisamment de mou dans le câble ventilé à la surface pour pouvoir soulever l’AquaVent Wellhead de la  
base du couvercle du puits, afin d’accéder à la connexion du câble ventilé ou d’effectuer une mesure manuelle de la profondeur  
jusqu’au niveau de l’eau, sans perturber l’enregistreur AquaVent 5 de sa position au fond du trou.

Figure 8-5 : Installation à l’aide du support de suspension

Raccordez le câble ventilé à la tête de puits Wellhead. Reportez-vous à la section 1.5.1 pour plus de détails. Effectuez 
une mesure  manuelle de la profondeur jusqu’au niveau de l’eau pour vos dossiers. 
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8.3 Orientation de l'enregistreur

Il est conseillé d’installer l’enregistreur LevelVent 5 ou AquaVent 5 en position  
verticale. Toutefois, une installation en position inclinée ou horizontale est  
acceptable. 

La ligne de mesure du capteur de pression est indiquée par la ligne usinée  autour 
du corps de l’enregistreur, juste au-dessus des orifices d’accès pour la  pression 
(voir Figure 8-6). 

Le transducteur de pression est orienté dans un plan normal à l’axe long du  corps, 
et détecte la pression dirigée dans le plan de l’axe long. En position  verticale, le 
capteur détecte la pression au-dessus de la ligne du transducteur  de pression. En 
position autre que verticale, le point de pression zéro est  proportionnel à l’angle 
d’inclinaison. 

Figure 8-6 :  Ligne de mesure de 
l’enregistreur

8.4 Profondeur d’installation de l’enregistreur

Estimez correctement les niveaux d’eau minimum et maximum prévus au cours de la période de surveillance.  
Comme il mesure la hauteur d’eau au-dessus du capteur, l’enregistreur doit être installé de sorte qu’il demeure  
immergé en tout temps. Cependant, l’enregistreur ne doit pas être installé à une profondeur telle qu’il touche  
le fond du puits ou d’une voie (évitez l’immersion dans les sédiments).  

La profondeur d’immersion maximale au cours de la période de surveillance doit également rester à l’intérieur  
de ses limites spécifiées. Immerger l’enregistreur au-delà de sa limite spécifiée peut pressuriser le transducteur  
de pression de manière excessive et l’endommager. Les enregistreurs LevelVent et AquaVent sont garantis  
jusqu’à 200 % de leur pleine échelle de mesure, mais, l’exactitude ne peut pas être garantie au-delà de la  
pleine échelle. 

8.5 Précautions d’installation 

Abaissez avec précaution l’enregistreur dans l’eau. L’impact d’une chute brusque de l’enregistreur dans l’eau  
pourrait endommager le capteur de manière permanente. Veiller à ne pas faire tomber l’enregistreur sur une  
surface dure.   

D’autres considérations importantes à garder à l’esprit lors de l’installation de l’enregistreur dans des  
emplacements sous pression continue ou sous pression par intermittence, tels que des récipients sous pression,  
des tuyaux sous pression, des conditions de flux pulsé, des chutes ou à proximité d’ouvrages hydrauliques,  
est de l’effet potentiel des coups de bélier, provoqués par l’eau ou la vapeur, ou à des ressauts hydrauliques. 

Les coups de bélier provoqués par l’eau sont causés par un brusque changement de direction de l’écoulement  
à la suite d’une augmentation subite de la pression. Les coups de bélier provoqués par la vapeur se produisent  
lorsque de la vapeur entre dans un tuyau froid partiellement rempli d’eau. L’effet de bélier a le potentiel  
d’augmenter considérablement la pression hydraulique, ce qui peut exposer le capteur de pression à des  
pressions supérieures à sa cote maximale.  

Les ressauts hydrauliques sont un phénomène qui se produit lorsque l’eau est « soulevée » ou « repoussée » par  
la vélocité ou des obstructions de l’écoulement. Les ressauts hydrauliques créent des turbulences et provoquent  
des conditions de hauteur non représentatives dans la colonne d’eau. Des précautions doivent être prises pour  
éviter d’installer l’AquaVent dans des endroits susceptibles d’être exposés à des ressauts hydrauliques.
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8.6 Installation dans des environnements extrêmes

8.6.1 Conditions de congélation ou de température élevée

L’installation dans des endroits exposés à des risques de gel n’est pas recommandée sans prendre des  
précautions particulières. Lorsque l’eau gèle, son volume augmente d’environ 9 %. Une expansion de 9 % peut  
provoquer une pression extrême. Par conséquent, une congélation complète a le potentiel d’endommager le  
capteur de pression, qui est coté pour résister jusqu’à 200 % des variations dans sa plage de profondeur. C’est  
pourquoi vous devez choisir soigneusement un transducteur de pression dont la plage de pression convient à  
votre application. 

Remarque : Bien qu’il soit possible de prendre des précautions, placer un enregistreur LevelVent 5 ou AquaVent 5 dans une  
situation où l’eau peut geler peut endommager le capteur de manière permanente.

Lors de la surveillance d’eaux de surface ou souterraines peu profondes susceptibles de geler, la meilleure  
manière d’éviter que le capteur ne soit endommagé consiste à abaisser le transducteur à une profondeur dans  
la colonne d’eau qui se trouve en dessous de la ligne de gel ou de formation de glace. Lors de la surveillance  
d’eaux de surface peu profondes comme des ruisseaux, des marécages ou des étangs, où le gel peut atteindre  
le fond, installez l’enregistreur LevelVent 5 ou AquaVent 5 dans un puits de stabilisation ventilé enterré dans  
le fond de l’eau, au-delà de la ligne de gel. 

Dans les cas où les précautions ci-dessus ne peuvent être prises et que l’enregistreur LevelVent 5 ou AquaVent 
5  doit être installé dans un endroit susceptible de geler, il est recommandé de placer l’enregistreur à l’intérieur  
d’un ballon scellé à paroi épaisse, rempli avec d’une solution antigel non toxique et non corrosive. Placez  
le ballon dans une section de tube perforé de 30 mm (1,25 pouce) de diamètre intérieur, puis installez  
l’enregistreur dans l’eau à surveiller. La solution antigel protégera l’enregistreur contre l’expansion de la glace  
au niveau du transducteur de pression, tout en transmettant toutes les variations de pression et de température  
qui se produisent. Toutefois, veuillez prendre soin de noter que même si ces précautions sont prises, il existe  
toujours un risque, lorsqu’un enregistreur LevelVent ou AquaVent est installé dans une situation où l’eau peut  
geler, que le capteur subisse des dommages permanents.

Veuillez noter qu’une protection d’installation similaire peut être utilisée lorsque l’enregistreur est utilisé pour  
surveiller des liquides qui sont incompatibles avec ses matériaux. 

La plage de températures de fonctionnement d’un enregistreur LevelVent ou AquaVent est de -20 à 80 °C  (-4 
180 °F). À l’autre extrémité de l’échelle thermique, exposer l’enregistreur à des températures supérieures  à 80 
°C peut endommager les piles ou les parties électroniques, ou provoquer d’autres dommages.

8.6.2 Installations marines ou saumâtres

Lors de l’installation d’un enregistreur LevelVent ou AquaVent dans de l’eau salée ou saumâtre, ou dans un  
liquide ayant une densité relative différente de celle de l’eau douce, il est possible de compenser la différence  
de densité en saisissant la densité du liquide faisant l’objet de la surveillance dans l’Assistant de données (voir  
section 6).

Il est possible d’utiliser un enregistreur LevelVent 5 ou AquaVent 5 pour surveiller des eaux salées ou saumâtres.  
Cependant, l’utilisation à long terme du corps en acier inoxydable d’un enregistreur LevelVent ou AquaVent  
dans l’eau salée ou saumâtre n’est pas recommandée, parce que le sel ou d’autres polluants peuvent causer  
des piqûres de corrosion qui peuvent entraîner la perforation de l’enveloppe de l’enregistreur. Pour minimiser  
cet effet, soulevez régulièrement l’enregistreur du liquide. En quelques secondes une fine couche de protection  
se formera par oxydation. 

Si vous utilisez un enregistreur LevelVent ou AquaVent dans une situation de surveillance continue dans des  
eaux salées ou saumâtres, le corps en acier inoxydable de l’enregistreur peut être protégé d’une manière  
analogue à celle utilisée pour la protection contre le gel décrite à la section 8.6.1. L’enregistreur LevelVent  
ou AquaVent peut être placé à l’intérieur d’un ballon scellé à paroi épaisse, rempli avec d’une solution antigel  
non toxique et non corrosive, comme de l’eau du robinet. Lorsque la pression varie, le liquide entourant  
l’enregistreur transmet la différence de pression au transducteur de pression.
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8.6.3 Conditions d’encrassement biologique

L’encrassement biologique est l’accumulation indésirable de microorganismes,  
de plantes, d’algues et d’organismes comme les anatifes, les moules et autres  
coquillages sur une surface mouillée. Chaque fois qu’un enregistreur LevelVent  
ou AquaVent est déployé pour une période de temps prolongée, notamment  
dans un environnement d’eau salée, il existe un risque d’encrassement  
biologique. L’encrassement biologique sur un capteur de pression peut  
affecter la précision des mesures.

Il est possible d’utiliser la protection Solinst contre l’encrassement  biologique 
pour protéger un enregistreur LevelVent ou AquaVent contre  l’encrassement 
biologique. La protection en Delrin à spires de cuivre réduit  naturellement 
l’encrassement biologique et prolonge la durée de déploiement  d’un 
enregistreur de données avant que son entretien ne soit nécessaire.  La 
protection contre l’encrassement biologique se glisse simplement sur  
l’extrémité capteur de l’enregistreur où elle est maintenue en place par son  
raccord à compression. Elle ajoute environ 19 mm (3/4 po) à la longueur  
d’un enregistreur. Elle permet à l’eau d’entrer librement dans les orifices du  
transducteur de pression. Elle peut être remplacée, le cas échéant.

42 mm  (1,65 
po) 

105 mm

105 mm  
4-1/8 po 

Figure 8-7 : Dimensions de la  
protection contre l’encrassement  

biologique

Figure 8-8 : Protection Solinst contre l’encrassement biologique
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9 Maintenance de l'enregistreur de données ventilé

Comme avec tout projet de surveillance d’eaux souterraines ou d’eaux de surface, vous devez sélectionner  
l’équipement approprié et définir un programme d’entretien basé sur l’environnement de surveillance  
spécifique à votre application.

Pour un enregistreur LevelVent ou AquaVent, cela signifie sélectionner une plage de pression appropriée, en  
s’assurant que les températures de surveillance sont conformes aux spécifications des instruments, et s’assurer  
que les matériaux mouillés sont compatibles avec l’environnement chimique du site.

9.1 Entretien de l'enregistreur

L’entretien d’un enregistreur consiste à nettoyer la partie extérieure de l’enveloppe et des trous de circulation.  
La fréquence de nettoyage dépend de plusieurs aspects de la qualité de l’eau faisant l’objet de la surveillance.  
Dans l’eau douce avec une qualité d’eau allant de bonne à excellente, les exigences de nettoyage de l’enregistreur  
sont réduites à un minimum, à savoir une inspection d’entretien annuelle ou saisonnière. 

Dans la plupart des cas, le nettoyage peut être accompli en rinçant l’enregistreur à l’aide d’un produit de  
nettoyage ménager doux, non abrasif, ne laissant pas de résidus, avec une brosse en plastique très souple,  
aux soies douces, pour le nettoyage de tuyaux. N’insérez aucun objet à travers les orifices de circulation à  
l’extrémité capteur de l’enregistreur. 

Dans certains cas, de simples produits de nettoyage ne sont pas suffisants pour nettoyer correctement un  
enregistreur. Plusieurs conditions courantes des eaux nécessitent des méthodes d’entretien particulières. Cela  
inclut les eaux dures, les charges élevées de solides en suspension, l’encrassement biologique ou chimique, et  
les conditions d’eaux salées ou saumâtres. 

La surveillance de l’eau dure peut entraîner la précipitation de dépôts de calcium ou de magnésium sur  
le transducteur de pression, ainsi que sur d’autres composants de l’enregistreur. Ces dépôts peuvent être  
facilement dissous, en toute sécurité, à l’aide d’une solution diluée (généralement moins de 10 %) d’acide  
acétique ou d’acide phosphorique. Des produits pour un usage ménager sont également disponibles sur le  
marché pour dissoudre les dépôts de tartre. L’utilisation de produits de détartrage de qualité industrielle, et  
beaucoup plus puissants, n’est pas recommandée pour le nettoyage de l’enregistreur. 

Des charges élevées de solides en suspension peuvent bloquer les orifices de circulation ou  obstruer la 
cellule manométrique interne de l’enregistreur. L’effet du colmatage potentiel par  des dépôts solides peut 
être minimisé en plaçant l’enregistreur dans des zones d’écoulement.  Pour retirer l’accumulation de matières 
solides, rincez l’enregistreur sous un débit faible d’eau du robinet  jusqu’à ce que les particules soient emportées.

L’encrassement bactériologique ou chimique peut être une considération importante dans de nombreuses  
eaux de surface et les projets de surveillance d’eaux de surface. Les bactéries sessiles utilisent souvent les  
instruments installés comme un substrat de fixation. Le dépôt chimique peut résulter de la charge électrique  
différentielle entre les instruments du liquide faisant l’objet de la surveillance ou d’activité biologique ou d’algues.  
Les deux formes d’encrassement biologique peuvent créer des dépôts difficiles à retirer sur le transducteur, les  
fils conducteurs et le boîtier de l’enregistreur. Pour retirer l’encrassement biologique, utilisez une solution diluée  
(≤ 10 %) d’acide sulfurique. Les résidus éventuels peuvent nécessiter un traitement pendant plusieurs heures.
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Pour les enregistreurs utilisés avec des câbles ventilés de style ancien (vendus avant le 16/4/21 
avec des numéros de série inférieurs à 506326), le remplacement du joint torique doit être effectué 
régulièrement. Le joint torique assure l’étanchéité de la connexion du câble ventilé, ce qui est important pour 
empêcher l’humidité d’entrer. Les joints toriques de remplacement sont disponibles par lot de dix auprès de 
Solinst.

Figure 9-1 : Joint torique au niveau du raccordement du câble ventilé

Un entreposage approprié, lorsque l’appareil n’est pas utilisé, est important. L’enregistreur doit être  
entreposé avec le couvercle protecteur vissé sur le connecteur du câble ventilé. L’étui rigide dans lequel  
l’enregistreur a été fourni doit également être utilisé pour protéger l’appareil pendant son entreposage. 

Figure 9-2 : Enregistreur avec couvercle d’entreposage et étui de protection

9.2 Entretien du câble ventilé

L’entreposage approprié du câble ventilé est très important. Les câbles ventilés sont livrés avec des bouchons  
sur leurs extrémités. Ces bouchons doivent être conservés et utilisés pour sceller les connexions d’un câble  
ventilé lorsqu’il n’est pas utilisé et pendant les périodes d’entreposage. Il est également recommandé de  
conserver le câble ventilé sur la bobine sur laquelle il a été fourni (dans le cas de longueurs importantes). Cela  
protège le câble et évite que le tube de ventilation ne soit plié. 

Remarque : Avant l’expédition des câbles ventilés, les tubes de ventilation sont séchés avec de l’azote, puis bouchés  
hermétiquement, afin de garantir l’absence d’humidité pendant le transport. Mettez les couvercles de côté et conservez-les.

Pour s’assurer que le tube de ventilation est sec avant tout déploiement ou entreposage, Solinst propose un  
raccord spécial qui permet de souffler de l’azote dans le tube. Reportez-vous à la section 9.2.1.

Le nettoyage des raccords garantit une bonne étanchéité. Il est possible d’utiliser un coton-tige pour 
retirer  toute trace d’humidité ou de débris sur les connecteurs.

Figure 9-3 : Entretien du câble ventilé
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9.2.1 Raccord de soufflage de câble ventilé

Il est conseillé d’utiliser le raccord d’aération du câble ventilé pour sécher le tube de ventilation avant de  
commencer un nouveau projet ou avant d’entreposer le câble ventilé. 

Figure 9-4 : Raccord d’aération du câble ventilé

Pour utiliser le raccord d’aération du câble ventilé :

Remarque : Respectez toujours le protocole de protection personnelle lorsque vous travaillez avec un gaz comprimé.

1.	 Retirez les capuchons de stockage des deux extrémités du câble ventilé (n'oubliez pas de conserver les capuchons). 
Ou s'il est déployé, retirez l'enregistreur et la tête de puits. 

2.	 Connectez une extrémité du câble ventilé à la connexion correcte sur le raccord de soufflage. Assurer un bon 
alignement avant de pousser la connexion ensemble. Tournez le raccord sur le raccord de soufflage jusqu'à ce qu'il 
soit en place. Ne pas tordre le câble ventilé, le corps du connecteur de câble ou le raccord de soufflage. 

Remarque : Lorsque vous raccordez le raccord d’aération, veillez à ne pas tordre le raccord d’aération, le câble ventilé ou le corps  
en acier inoxydable du connecteur du câble. Faites uniquement tourner le raccord en acier inoxydable. 

Connexion du  
câble ventilé

Connexion  au 
raccord du  

réservoir d’azote

Raccord du câble ventilé  en 
acier inoxydable

Figure 9-5 : Câble ventilé connecté au raccord d’aération

3.	 Connectez l'autre extrémité du raccord de soufflage 
au raccord de tuyau de réservoir d'azote. 

4.	 Appliquez lentement 25-30 psi d'azote gazeux à 
l'évent Câble. Laissez la pression s'écouler à travers le câble 
pendant environ 5 minutes. Si vous n'entendez aucun flux 
d'air, vous pouvez appliquer à 50 psi de pression pour 
éliminer tout blocage. 

Remarque : Ne pas dépasser une pression de 50 psi lorsque  
vous utilisez le raccord d’aération du câble ventilé.

5.	 Coupez le débit d'azote gazeux et retirez l'évent  	
Câble du raccord de soufflage. 

6.	 Si vous déployez l'enregistreur de données, connectez-
en immédiatement un l'extrémité du câble ventilé à 
l'enregistreur, et le autre à la tête de puits. Voir la section 
1.5.1 pour instructions de connexion. 

7.	 Si vous stockez le câble ventilé, installez immédiatement 
le capuchons de rangement aux deux extrémités du câble 
ventilé. 

Figure 9-6 : Azote soufflé à travers le câble ventilé
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Raccord de connexion  
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9.3 Entretien de la tête de puits

Le remplacement des piles d’une tête de puits AquaVent Wellhead doit être effectué sur une base régulière,  
en fonction de l’utilisation. Reportez-vous à la section 8.2.1 pour des estimations de l’autonomie des piles et  
des consignes d’installation. 

Remarque : Après avoir récupéré les paramètres dans le logiciel Levelogger, si les piles de la tête de puits Wellhead sont drainées  
à 20 % ou moins de leur charge, un message d’avertissement apparaît pour inviter l’utilisateur à remplacer les piles. 

Pour les têtes de puits utilisées avec des câbles ventilés de style plus ancien (vendus avant le 16/4/21 
avec des numéros de série inférieurs à 506326), le remplacement du joint torique au niveau du connecteur 
du câble ventilé doit être effectué régulièrement. Le joint torique assure l’étanchéité de la connexion du câble 
ventilé, ce qui est important pour empêcher l’humidité d’entrer. Les joints toriques de remplacement sont 
disponibles par lot de dix auprès de Solinst.

Lorsqu’elle n’est pas utilisée, la tête de puits Wellhead doit être entreposée avec le bouchon cache-poussière  
en place sur le connecteur du câble ventilé. Les bouchons cache-poussière bleus doivent également être  
placés sur le(s) connecteur(s) pour câble, sur le côté de la tête de puits AquaVent Wellhead, et le bouchon 
antipoussière  noir sur le dessus de la tête de puits LevelVent Wellhead. 

Figure 9-7 : Joint torique et bouchon cache-poussière de la Wellhead au niveau du raccordement du câble ventilé
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10 Utilitaire de diagnostic

Il est possible d’utiliser l’utilitaire de diagnostic du logiciel Levelogger pour résoudre les problèmes de base des  
enregistreurs de données et obtenir des informations qui peuvent aider le représentant du service d’assistance  
technique de Solinst à identifier et à résoudre les problèmes que vous pourriez rencontrer. L’utilitaire de  
diagnostic peut être lancé à partir du menu Utilities (Utilitaires) dans la partie supérieure de la fenêtre du  
logiciel. Il est possible d’utiliser l’utilitaire pour effectuer un autodiagnostic, faire un vidage de la mémoire,  
créer et envoyer des rapports, ou encore réinitialiser indicateur des piles de l’AquaVent.

10.1 Exécuter les diagnostics

La fonction Run Diagnostics (Exécuter les diagnostics) lit les informations suivantes de l’enregistreur de  
données :
	 1)	 numéros de série de l’enregistreur et de la tête de puits AquaVent Wellhead
	 2)	 numéro de modèle de l’enregistreur
	 3)	 versions du microprogramme de l’enregistreur et de la tête de puits AquaVent Wellhead
	 4)	 tension des piles
	 5)	 niveau de charge des piles
	 6)	 Batterie restante
	 7)	 relevé du niveau actuel
	 8) 	 relevé de la température actuelle
	 9)	 Lecture de la température Max/Min
	 10)	 Lecture de la pression maximale
	 11)	 Enregistrements de données

Ces informations peuvent être utilisées pour identifier l’état du micrologiciel, de la batterie et/ou du capteur 
de température/pression Cette fonction exécute également une série d’autotests sur le collecteur de données 
afin de vérifier les problèmes de batterie, de mémoire, d’oscillateur, de capteur de pression/température Pour 
exécuter cette fonction, il suffit de cliquer sur le bouton “Run Diagnostics” Si l’un de ces tests échoue, un 
rapport doit être créé et envoyé par e-mail à service@solinst.com.

Figure 10-1 : Exécuter les diagnostics
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10.2 Vidage de la mémoire

Cette fonction crée un vidage complet de la mémoire de l’enregistreur de données, qui peut ensuite être 
envoyé à service@solinst.com pour être analysé, ou converti en fichiers *.xle que vous pouvez ouvrir dans 
l’onglet Contrôle des données. 

Remarque : Il est recommandé, avant d’essayer d’utiliser cette fonction, de cliquer sur le bouton « Create Report » (Créer un  
rapport) pour envoyer un rapport à l’assistance technique de Solinst.

Pour exécuter cette fonction, cliquez simplement sur le bouton « Read Memory Dump » (Effectuer un vidage  
de la mémoire). Effectuer un vidage de la mémoire crée un fichier *.xle contenant les données sauvegardées.

Figure 10-2 : Effectuer un vidage de la mémoire

10.2.1 Conversion de fichiers (hex en xle)

Cette fonction convertit le fichier *.hex qui a été créé et enregistré avec la fonction Read Memory Dump, 
en fichiers *.xle que vous pouvez ouvrir dans l'onglet Data Control, ou envoyer à Solinst pour un support 
technique. Une liste des fichiers créés s'affiche.

Figure 10-3 Liste de conversion de fichiers Hex vers _xle
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Figure 10-4 Fenêtre de saisie des informations client

Figure 10-5 Exemple de rapport

10.4 Envoi du rapport par e-mail

En cliquant sur Rapport par courriel, vous serez guidé dans le processus de création d’un rapport de diagnostic, 
et le rapport sera automatiquement joint à un courriel à envoyer à service@solinst.com pour le dépannage.

10.5 Mises à jour du logiciel/microprogramme

Chaque fois que l’utilitaire de diagnostic est ouvert, il vérifie automatiquement si des mises à jour du logiciel  
sont disponibles. Si une mise à jour est disponible, « Software Update Available » (Nouvelle version du logiciel  
disponible) apparaît en haut à droite de la fenêtre. Lorsque vous cliquez sur le message, une page Web s’ouvre  
pour vous permettre de télécharger la mise à jour du logiciel.

Remarque : Votre ordinateur doit disposer d’une connexion Internet pour vérifier si des mises à jour du logiciel ou du  
microprogramme sont disponibles.

Remarque : Vous pouvez également vérifier si des mises à jour sont disponibles en utilisant le menu Help (Aide).

L’utilitaire vérifie également si une nouvelle version du microprogramme est disponible. « Firmware Update  
Available » (Nouvelle version du microprogramme disponible) apparaît en haut à droite de la fenêtre. Lorsque  
vous cliquez sur le message, une page Web s’ouvre pour vous permettre de télécharger la mise à jour du  
microprogramme. Reportez-vous à la section 11 pour les instructions de mise à jour du microprogramme.

10.3 Créer un rapport

Cette fonction crée simplement un fichier texte contenant les informations obtenues à partir de la fonction 
Run Diagnostics. Lorsque vous cliquez sur le bouton Create Report (Créer un rapport), une fenêtre s’ouvre et 
vous demande de fournir les informations relatives à votre entreprise. Remplissez-les simplement et le rapport 
résultant peut être sauvegardé ou envoyé à service@solinst.com pour le dépannage.

Remarque : L’option « Email Report » (Envoi du rapport) crée automatiquement un rapport et l’envoie par e-mail à l’assistance  
technique de Solinst, le tout en un seul clic.
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Figure 10-5 : Réinitialisation de l’indicateur des piles de l’AquaVent

10.7 Effacer le zéro d’un enregistreur de données

Pour effacer le zéro précédemment calibré d’un enregistreur (voir section 4.8), cliquez sur « Clear Datalogger  
Zero » (Effacer le zéro de l’enregistreur de données). 

10.6 Réinitialiser l’indicateur des piles de l’AquaVent

Après avoir remplacé les piles de la Wellhead, vous devez réinitialiser l’indicateur des piles dans le logiciel  
Levelogger. Pour ce faire, cliquez sur le bouton « Run Diagnostics » (Exécuter les diagnostics), puis cliquez sur  
le bouton « Reset AquaVent Battery Indicator » (Réinitialiser l’indicateur des piles de l’AquaVent). 

10.7 Effacer le zéro d’un enregistreur de données
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11 Utilitaire de mise à jour du microprogramme

Avec l’enregistreur connecté à la Wellhead par le câble ventilé, utilisez le câble USB d’interface PC pour raccorder  
la tête de puits LevelVent Wellhead à l’ordinateur, ou utilisez le câble de connexion USB pour raccorder la tête de  
puits LevelVent Wellhead à l’ordinateur. 

Remarque : Pour vérifier l’existence de mises à jour du microprogramme à l’aide du logiciel Levelogger, récupérez les paramètres de  
l’enregistreur de données connecté (voir section 4). Si une mise à jour est disponible, « Firmware Update Available » (Nouvelle version du  
microprogramme disponible) apparaît en haut à droite de la fenêtre. Lorsque vous cliquez sur le message, une page Web s’ouvre pour 
vous  permettre de télécharger la mise à jour du microprogramme. Vous pouvez également utiliser le menu Help (Aide) du logiciel. 

La tête de puits SPX AquaVent Wellhead a également besoin d’une alimentation électrique branchée au câble  de 
connexion SDI-12/MODBUS, afin d’effectuer la mise à jour de la version du Firmware. Reportez-vous aux  manuels 
d’utilisation séparés pour obtenir des instructions pour le raccordement électrique. 

L'utilitaire de mise à jour du micrologiciel est utilisé pour télécharger de nouveaux fichiers de micrologiciel sur un 
enregistreur LevelVent, un enregistreur AquaVent et/ou une tête de puits SPX AquaVent. L'utilitaire de mise à 
jour du micrologiciel peut être lancé à partir du menu Utilitaires en haut du logiciel Levelogger. Le fichier zippé du 
micrologiciel peut être obtenu à l'adresse suivante : https://www.solinst.com/downloads/

Remarque Pendant que le micrologiciel est en cours de mise à jour, la tête de puits SPX ignorera ou fournira une réponse hors délai à 
toute demande provenant du réseau MODBUS ou SDI-12. 

Assurez-vous de décompresser le fichier du microprogramme après l'avoir téléchargé, afin de pouvoir accéder au 
fichier *.ssf. Il y a des fichiers de firmware séparés disponibles ; un pour l'enregistreur LevelVent, un pour l'enregistreur 
AquaVent et un pour le SPX AquaVent Wellhead. Mettez à jour chaque composant matériel séparément ; mettez à 
jour l'AquaVent Wellhead avant de mettre à jour l'AquaVent logger. 

Remarque : Il est important que la communication entre le PC et l’enregistreur de données ne soit pas interrompue pendant le  
téléchargement d’un microprogramme. Veillez donc à fermer tous les autres programmes en cours d’exécution, y compris les écrans de  
veille, et à ne pas débrancher l’enregistreur de données avant que le téléchargement ne soit terminé.

Figure 11-1 : Fenêtre « Firmware Upgrade Utility 
»  (Utilitaire de mise à jour du microprogramme)

Pour télécharger le nouveau microprogramme à un enregistreur ou à une tête de puits AquaVent Wellhead, suivez  
les étapes suivantes :

1) 	 Ouvrez l’utilitaire de mise à niveau du micrologiciel Solinst dans le menu Utilitaires dans la fenêtre principale du 
logiciel Levelogger. Sélectionnez le port de communication à laquelle le collecteur de données est connecté dans le menu 
déroulant.  

2) 	 Cliquez sur le bouton 'Ouvrir' , ce qui devrait ouvrir une boîte de dialogue de fichier demandant pour le fichier de 
firmware (*.ssf) à télécharger. Naviguer vers le répertoire où le fichier du micrologiciel a été enregistré sur votre PC, puis 
cliquez sur le fichier et cliquez sur « Ouvrir ».

3) 	 Cochez la case « Informations sur le fichier » pour vous assurer que le fichier 
ouvert est correct.

4) 	 Cliquez sur le bouton « Télécharger le micrologiciel » , pour démarrer le 
firmware processus de téléchargement. 

Remarque : Si un processus de mise à jour de la SPX Wellhead échoue ou est  interrompu, 
alors la récupération peut nécessiter de l’éteindre et de la remettre en  route, ce qui se fait 
généralement en débranchant le câble de connexion USB et le  câble de connexions du 
MODBUS/SDI-12, puis en les rebranchant après 30 secondes. 

5)	 Si une erreur de communication se produit et est indiquée dans le 'Datalogger 
Case d'état avant ou après la «  Vérification du micrologiciel  » et messages 
« Chargement du micrologiciel dans l'enregistreur de données », puis redémarrez le 
processus de mise à niveau.

6)	 Si, toutefois, une erreur de communication se produit entre le « Vérification 
Firmware » et les messages « Loading Firmware to Datalogger », alors s'il vous plaît 
contactez Solinst. Vous devrez donner à l'enregistreur de données Numéro de série 
et expliquer le positionnement exact de l'erreur message.
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12 Diagnostic des anomalies

12.1 Problèmes durant l’installation du logiciel Levelogger

« Class not Registered » (Catégorie non enregistrée) ou « DLL not found » (DLL non trouvé) ou « Access  
violation » (Violation d’accès) 

1)	 Il se peut que vous ne disposiez pas des droits d’administrateur pour installer le logiciel dans l’environnement 
Windows 10 ou 11. 

2)	 Certains fichiers ont été corrompus lors de l'installation du logiciel Levellogger. Utilisez « Ajouter/Supprimer 
des programmes » pour désinstallez, puis installez une nouvelle copie actuelle du dernier logiciel Levellogger à 
partir de : https://www.solinst.com/downloads/

12.2 Erreur pendant le processus de désinstallation du logiciel

Le programme "Ajouter/Supprimer" ne peut pas localiser le  Levelogger.

L’entrée doit être supprimée dans le tableau d’enregistrement : 

1) 	 Demandez à votre administrateur système d’effectuer la suppression.

2)	 Reportez-vous au lien suivant sur site Web de Microsoft pour obtenir des instructions :  
http://support.microsoft.com/default.aspx?scid=kb;en-us;247501

12.3 Les données ont été effacées par accident

Si un modèle plus ancien d’enregistreur de données LevelVent ou AquaVent a été redémarré sans que les  
anciennes données aient été sauvegardées, cliquez sur « Download Options » (Options de téléchargement),  
puis sélectionnez « Data Recovery » (Récupération de données). Cela télécharge les enregistrements  
immédiatement antérieurs. 

12.4 Messages d’erreur au cours de l’utilisation du logiciel

« Communication Time Out » (Expiration du délai de communication) ou « Communication Error 
»  (Erreur de communication) ou « The Command that is sent to the Levelogger is not defined » (La  
commande qui est envoyée au Levelogger n’est pas définie)

1) 	 Essayez de communiquer avec un autre enregistreur de données, une tête de puits Wellhead, un câble ventilé  
ou un câble USB d’interface/connexion PC.

2) 	 Nettoyez les connexions du câble ventilé à l’enregistreur et à la tête de puits.

3)	 Vérifiez que le câble USB PC Interface/Connector est connecté au même port Com que celui choisi dans le  	
milieu supérieur de la fenêtre principale du logiciel Levellogger.

4)	 Vérifiez la configuration des paramètres du port de communication. Ils doivent être comme suit :

•	 Bits par seconde : 9 600
•	 Bits de données : 8
•	 Parité : Aucune
•	 Bits d’arrêt : 1
•	 Contrôle de débit : Aucun (Cela peut avoir été réglé sur Xon/Xoff - changez-le sur Aucun, 
sélectionnez [OK] et de sortir de cette voie.)
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La procédure pour afficher les paramètres de configuration du port COM est la suivante :

a.	 Sélectionnez le Panneau de configuration
b.	 Double-cliquez sur System (Système)
c.	 Sélectionnez l’onglet Device Manager Tab (Gestionnaire de périphériques)
d.	 Double-cliquez sur Ports
e.	 Double-cliquez sur Communications Port(s) (Port(s) de communication)
f.	 Choisissez l’onglet Port Settings Tab (Paramètres du port)

5) 	 Essayez d’utiliser un autre ordinateur, pour voir si c’est la cause du problème.

6) Si le problème persiste, contactez Solinst.

« Port Cannot Open » (Le port ne peut pas s’ouvrir)

1) 	 Assurez-vous d'avoir branché le câble d'interface/connecteur PC USB sur le PC avant de démarrer Levelogger  	
Logiciel.

2)	 Assurez-vous que le bon port de communication est sélectionné dans la partie supérieure de la fenêtre principale  
du logiciel Levelogger.

3)	 Vérifiez si un autre logiciel utilise le même port Com en arrière-plan. Fermez ce logiciel ou  	 choisissez un 
autre port Com si disponible. Un tel logiciel d'arrière-plan peut être un logiciel antivirus ou un logiciel PDA.

4)	 Assurez-vous que le port de communication a été activé : 

a.	 Sélectionnez Control Panel (le Panneau de configuration)
b.	 Double-cliquez sur System (Système)
c.	 Sélectionnez l’onglet Device Manager Tab (Gestionnaire de périphériques)
d.	 Double-cliquez sur Ports
e.	 Double-cliquez sur Communications Port(s) (Port(s) de communication)
f.	 Choisissez General (Général) 
g.	 Désactivez la coche ‘Disable in this harware profile box’ (« Désactiver dans ce profil matériel »)

« File Create Error » (Erreur de création de fichier) et « File Write Error » (Erreur d’écriture de fichier)

1) 	 Si vous n'avez pas de privilèges d'écriture de fichiers dans le dossier de données par défaut, modifiez le dossier 
comme suit  : dans le Levelogger  Logiciel, cliquez sur 'Configuration' puis 'Paramètres de l'application'. Sous 
« Répertoire par défaut », entrez une nouvelle destination  dossier, dans lequel vous avez des privilèges d'écriture 
de fichier, par exemple 'Mes Documents'. Suivez la même procédure si vous avez le même problème lorsque vous 
exportez le fichier de données au format csv. 

2)	 2) Demandez à votre administrateur système pour obtenir de l’assistance.

« File Open Error » (Erreur d’ouverture de fichier) et « File Read Error » (Erreur de lecture de fichier)

1)	 Arrêtez ou désactivez tout autre logiciel qui est actif et qui utilise le même fichier.

2)	 Dans le bloc-notes ou Wordpad, ouvrez le fichier <*.xle> pour vérifier que le fichier n’est pas corrompu.  
Comment les fichiers de données sont-ils terminés ?

3)	 Si le problème persiste, contactez Solinst pour obtenir de l’assistance.

« A different type of Levelogger is detected » (Un autre type de Levelogger est détecté)

Essayez de cliquer à nouveau sur l’icône « Retrieve Settings » (Récupérer la valeur des paramètres) ou  
remplacez l’enregistreur de données actuellement connecté avec celui qui fonctionnait précédemment, puis  
terminez l’opération. 

Data Corrupted » (Données corrompues)

Contactez Solinst pour obtenir de l’assistance. Utilisez l’utilitaire de diagnostic pour effectuer un vidage de la  
mémoire et envoyer le fichier avec le contenu à Solinst pour des analyses plus approfondies.
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« Internal Error » (Erreur interne)

Contactez Solinst pour obtenir de l’assistance.

« Fail to append data - A different Levelogger has been detected! » (Ne parvient pas à ajouter des  
données - un autre Levelogger a été détecté !) ou « Fail to append data - A different start time has  
been detected! » (Ne parvient pas à ajouter des données - une heure de démarrage différente a été  
détectée !) ou « Fail to append data - New data is not available in the Levelogger! » (Ne parvient pas  
à ajouter des données - de nouvelles données ne sont pas disponibles dans le Levelogger !) 

Le logiciel Levelogger ne peut ajouter des données à un fichier que s’il a le même numéro de série et la même  
heure de démarrage que l’enregistreur de données connecté. Identifiez le bon fichier ou utilisez « All Data »  
(Toutes les données) pour télécharger le fichier complet.

« Only Levelogger Gold/Edge/5 supports this function » (Seuls les enregistreurs Levelogger Gold/  
Edge/5 prennent en charge cette fonction)

Les fonctions « Append Data » (Ajouter les données), « Partial Download » (Téléchargement partiel) et « Data  
Recovery » (Récupération de données) ne sont prises en charge que par les enregistreurs Levelogger Gold/  
Edge/5/LevelVent/AquaVent.

« Schedule cannot be empty » (Le programme ne peut pas être vide)

Lorsque vous utilisez le mode d’échantillonnage « Schedule Sampling » (Programmé par l’utilisateur) pour un  
enregistreur de données, le programme doit renfermer au moins un élément.

« Readings in schedule exceed the maximum » (Le nombre de relevés dans le programme dépasse la  
limite maximale)

Le nombre de relevés dans un programme ne doit pas produire plus de 150 000 relevés individuels.
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